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Disclaimer

To the maximum extent permitted by applicable law, the products described (including its
hardware, software and firmware, etc.) in this document are provided AS IS, which may have flaws,
errors or faults. Yuejiang makes no warranties of any kind, express or implied, including but not
limited to, merchantability, satisfaction of quality, fitness for a particular purpose and non-
infringement of third party rights. In no event will Yuejiang be liable for any special, incidental,
consequential or indirect damages resulting from the use of our products and documents.

Before using our product, please thoroughly read and understand the contents of this document
and related technical documents that are published online, to ensure that the robotic arm is used on
the premise of fully understanding the robotic arm and related knowledge. Please use this document
with technical guidance from professionals. Even if follow this document or any other related
instructions, Damages or losses will be happen in the using process, Dobot shall not be considered
as a guarantee regarding to all security information contained in this document.

The user has the responsibility to make sure following the relevant practical laws and
regulations of the country, in order that there is no significant danger in the use of the robotic arm.

Certification specification

Dobot M1 has been certified as follows.

(€ FHC RoHs [¢

Shenzhen Yuejiang Technology Co., Ltd

Address: 3F, Building NO.3, Tongfuyu Industrial Town, Nanshan District, Shenzhen, China

Website: www.dobot.cc
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Preface

Purpose

This Document describes the functions, technical specifications, installation guide and system
commissioning of Dobot M1, making it easy for users to fully understand and use it.

Intended Audience
This document is intended for:
e Customer Engineer
e Sales Engineer
* Installation and Commissioning Engineer
*  Technical Support Engineer

Change History

Date Change Description

2018/06/30 | Add certification specification

Delete 3.5 (Optional) Installing soldering kit

Modify:

. 2.4.1 Technical Parameters: Modify the power parameter

. 3.4 (Optional) Installing Air Pump: Modify the figure of air pump connection
. 4.3.1 Power Adapter Interface: Add the link of Connection Power Supply

. 5.2 Connecting Power Supply: Add power adapter interface

. 6.50perating Laser Engraving: Modify the file format that Dobot M1 supports

. 6.6 Operating 3D Printing: Modify the 3D printing parameters

2018/01/31 | The first release

Add:

. 2.3.3 Arm Orientation

. 3.3.1 Installing Laser Engraving Kit
. 3.3.2 Installing 3D Printing Kit

. 3.5 (Optional) Installing soldering kit
. 5.2 Connecting Power Supply

. 5.5.6 Debugging Disabling Function
. 5.5.7 Debugging Homing Function
. 6.5 Operating Laser Engraving

. 6.6 Operating 3D Printing

. 7 Maintenance

Modify:

. Update the contents about GUI according to the newest M1Studio
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. 2.3.1 Workspace
. 2.4 Technical Specifications
. 5.4.1 Connecting Serial Port

. 6.1.2 Alarms Description

. 6.2 Operating Teaching and Playback

. 6.8 Operating Web Management

Symbol Conventions

The symbols that may be founded in this document are defined as follows.

Symbol

Description

ADANGER

Indicates a hazard with a high level of risk which, if not
avoided, could result in death or serious injury

AWARNING

Indicates a hazard with a medium level or low level of
risk which, if not avoided, could result in minor or

moderate injury, robotic arm damage

ANOTICE

Indicates a potentially hazardous situation which, if not
avoided, can result in robotic arm damage, data loss, or

unanticipated result

LANOTE

Provides additional information to emphasize or

supplement important points in the main text
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1. Security Precautions

This topic describes the security precautions that should be noticed when using this product.
Please read this document carefully before using the robotic arm for the first time. This product need
to be carried out in an environment meeting design specifications, you cannot remold the product
without authorization, otherwise it could lead to product failure, and even personal injury, electric
shock, fire, etc. People who use this product for system design and manufacture must be trained by
our company, relevant institution, or must have the same professional skills. The installation
personnel, operators, teaching personnel, programmers and system developers of the robotic arm
must read this document carefully and use the robotic arm strictly according to the regulations of
this document strictly.

1.1 General Security

ADANGER

Robotic arm is an electrical equipment. Non-professional technicians cannot modify the
wire, otherwise it is vulnerable to injury the device or the person.

The following security rules should be followed when using the robotic arm for industrial
design and manufacture.

You should comply with local laws and regulations when operating the robotic arm. The
security precautions in this document are only supplemental to local laws and regulations.

The DANGER, WARNING, and NOTICE marks in this document are only
supplemental to the security precautions.

Please use the robotic arm in the specified environment scope. If not, exceeding the
specifications and load conditions will shorten the service life of the product even damage
the equipment.

Please ensure that the robotic arm is operated under security conditions and there is no
harmful object around the robotic arm.

The hazardous area of the robotic arm is its workspace plus 100mm. In order to prevent
people from entering the work area accidentally, it is necessary to build the safety barrier
to prohibit people from entering the hazardous area.

When the temperature is close to the freezing temperature, the other operations on the
robotic arm will not be allowed until the robotic arm moves at the rate of 10% or less for
more than ten minutes to make itself warm up.

Highly corrosive cleaning is not suited to cleaning the robotic arm. The anodized
components are not suitable for immersion cleaning.

Please execute daily inspection and regular maintenance, replace the defective parts in
time, in order to keep the equipment in working order.

Please comply with the relevant laws to deal with the product which is scrapped, and
protect the environment.

Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
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People cannot repair and disassemble the robotic arm without professional training. If
there is a problem with the robotic arm, please contact Dobot technical support engineer
in time.

Before operating and maintaining the robotic arm, the personnel responsible for the
installation, operation and maintenance must be trained to understand the various security
precautions and to master the correct methods of operation and maintenance.

Only trained and trained personnel may commission and set up the robotic arm.

Commissioning of the incomplete machine is prohibited until it has been installed in a
machine and the whole machine complies with the provisions of the Machinery Directive
(2006/42/EC).

The robotic arm may only be operated with the associated standard equipment. Any other
use of tools is deemed to be inaccurate use.

Only authorized personnel who are instructed in work safety must work on the machine.

Before the operation, please wear protective clothing, such as antistatic uniform,
protective gloves and protective shoes.

It is prohibited to modify or remove the nameplates, instructions, icons and marks on the
robotic arm and the related equipment.

1.2 Service Security

AWARNING

It is necessary to shut off the power supply before installing the robotic arm, to prevent
any electric shock or malfunction.

The following security rules should be followed when using the robotic arm for installing,
teaching and programing.

Be careful during the robotic arm carrying or installing. Please follow the instructions on
the packing box to put down the robotic arm gently and place it correctly in direction of
arrow.

Before operating the robotic arm, please find and understand how to operate the
emergency stop function, ensure that the robotic arm can be stopped in an emergency.

You must connect the cables needed to the robotic arm first, and then power on the robotic
arm.

When operating the robotic arm over the PC, please do not enter the workspace of the
robotic arm, otherwise it will be vulnerable to injury the device or the person.

When the robotic arm is running, please do not touch the power and communication cables
at will. Before disconnecting the external equipment from the robotic arm, such as 3D
mouse, please make sure that the robotic arm is completely powered off.

When powering on robotic arm for the first time, please check Z-axis or J3 value from
M1Studio. If the value is below 10mm, an alarm about limitation is generated and
meanwhile the red indicator on the base of robotic arm is on, which is a normal
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phenomenon. At that point, you need to click J3+ under Joint coordinate system on the
M1Studio page to jog robotic arm to the position where the J3 value is above 10mm, and
then the alarm will be cleared.

*  When powering on for the first time, please ensure that the emergency stop switch has
been opened (The emergency stop button is bumped). Otherwise, the robotic arm will not
work normally. If the emergency stop switch is not opened, please rotate the emergency
stop button clockwise. The emergency stop button will be bumped when rotating to 45<

*  Please DO NOT connect power cable to Dobot M1 directly without power adapter.
Otherwise, the machine will be damaged.

Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
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2. Introduction

2.1 Overview

Dobot Master 1%t generation robotic arm (Dobot M1 for short) focuses on the light industrial
market with great potential, and supports teaching, playback, script control, blockly graphic
programming, laser engraving, 3D printing, vision identity and other functions, which is flexibly
used in intelligent sorting, circuit board soldering and other automatic production lines, so that it
can become the sword to solve practical problems for light industrial users, and can also become the
platform to carry the imagination of the maker. Dobot M1 has the following characteristics.

*  The integrated design of the driver and controller without external controller simplifies
the process of the initial installation and deployment.

*  The perfect calibration of servo motor, harmonic reducer and kinematic algorithm inside
Dobot M1 bring out the best of strength and speed.

e The maximum load is 1.5kg, and the repeatability is 0.02mm.
e Various I/0 and communication interfaces are provided for secondary development.
2.2 Appearance and Constitute

Dobot M1 consists of base, Z axis, Rear Arm, Forearm and R axis. Figure 2.1 shows the
appearance.

Rear arm
Forearm
R-Axis
~ em r—:' :
@
-
Z-Axis
Base
Figure 2.1 The appearance of Dobot M1
Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
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2.3 Working Principle
This topic describes the workspace, principle, size, and technical specifications of Dobot M1.

2.3.1 Workspace

Figure 2.2 shows the workspace.

‘PJS 'y

175 mm

d ™.
A 230mm

Figure 2.2 Workspace of Dobot M1

232 Coordinate System
Dobot M1 has two types of coordinate system, the joint one and the Cartesian one, as shown
in Figure 2.3 and Figure 2.4 respectively.

LAONOTE
The data shown in Figure 2.3 indicates the mechanical limitation.
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+360°

Figure 2.3 Joint coordinate system

Figure 2.4 Cartesian coordinate system
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* Joint coordinate system: The coordinates are determined by the motion joints.
Dobot M1 contains four joints.

e J1,J2,and J4 are the rotating joints, which are located and oriented in the horizontal
plane. And their axes are parallel to each other. The positive direction of these joints
is counter-clockwise.

e J3is the moving joint, which is used for the movement of the end effector in the
perpendicular plane. The positive direction of J3 is vertical upward.

*  Cartesian coordinate system: The coordinates are determined by the base.

e The origin is the axes center of the motor of Rear Arm where Rear Arm is dropped
to the bottom of the Z-axis screw.

*  The direction of X-axis is perpendicular to the base forward.
*  The direction of Y-axis is perpendicular to the base leftward.
*  The direction of Z-axis is vertical upward, which is based on the right hand rule.

e  The R-axis is the attitude of the end center relative to the origin of the robotic arm,
of which the positive direction is counter-clockwise. The R-coordinate is the sum of
the coordinates of J1, J2 and J4.

2.3.3 Arm Orientation

With two types of arm orientation (lefty hand orientation and righty hand orientation),
Dobot M1 can move to nearly any position and orientation within a given work envelope. You
need to specify the arm orientation when Dobot M1 is moving. If you fail to do so, Dobot M1
may move following an unexpected path, resulting in interference with peripheral equipment.
The arm orientations are shown as Figure 2.5 and Figure 2.6.

Figure 2.5 Righty hand orientation

Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
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234

Figure 2.6 Lefty hand orientation

Motion Function

The motion modes of Dobot M1 include Jogging, Point to Point (PTP), ARC, and CIRCLE.
2.3.4.1 Jogging Mode

Jogging mode is the mode jogging Dobot M1 along the Cartesian coordinate system or Joint
coordinate system when teaching.

LONOTE

This topic describes jogging mode by the GUI operation of M1Studio.

Cartesian coordinate system mode

Click X+, X- and Dobot M1 will move along X-axis in the negative or positive
direction.

Click Y+, Y- and Dobot M1 will move along Y-axis in the negative or positive
direction.
Click Z+, Z- and Dobot M1 will move along Z-axis in the negative or positive
direction.

Click R+, R- and Dobot M1 will rotate along R-axis in the negative or positive
direction.

Joint coordinate system mode

Click Joint1+, Jointl- and control Rear Arm to rotate in the negative or positive
direction.

Click Joint2+, Joint2- and control Forearm to rotate in the negative or positive
direction.

Click Joint3+, Joint3- and control Z-axis to move in the negative or positive
direction.

Click Joint4+, Joint4- and control R-axis to rotate in the negative or positive

Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
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direction.
2.3.4.2 Point to Point Mode (PTP)

PTP mode supports MOVJ, MOVL, and JUMP, which means point to point movement. The
trajectory of playback depends on the motion mode.

e MOVJ: Joint movement. From point A to point B, each joint will run from initial angle to
its target angle, regardless of the trajectory, as shown in Figure 2.7.

MOVJ

MOVL

A

Figure 2.7 MOVL/MOVJ mode

*  MOVL: Rectilinear movement. The joints will perform a straight line trajectory from
point A to point B, as shown in Figure 2.7.

e JUMP: From point A to point B, The joints will move in MOVJ mode, of which the
trajectory looks like a door, as shown in Figure 2.8.

1. Move up to the lifting Height (Height) in MOVJ mode.
2. Move up to the maximum lifting height (Limit).

3. Move horizontally to a point that is above B by height.
4

Move down to a point that is above B by height, which the height of the point
is that of point B plus Height.

5. Move down to Point B.

Limit » »

C?f' @

Height @ @

Figure 2.8 JUMP mode
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In JUMP mode, if the starting point or the end point is higher than or equal to Limit, or the
height that the end effector lifts upwards is higher than or equal to Limit, the trajectory is different
to that of Figure 2.8. Assuming that point A is the starting point, point B is the end point, Limit is
the maximum lifting height, and Height is the lifting height.

*  Point A and point B are both higher than Limit, but point A is higher than point B.

,,,,,,, Limit

*  Point A and point B are both higher than Limit, but point B is higher than point A.

A -
——————————————————————————————————————————————————————————————————————————————————————————————————— Limit
*  Point Ais higher than Limit, but point B is lower than Limit.
A
——————————————————————————————————— -~ Limit

*  The height of point A is the same as that of point B, but both are higher than Limit.

ffffffffffffffffffffffffffffffffffffffffffffffffffffffff Limit
e Point Ais lower than Limit, but point B is higher than Limit.
Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
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—————————————————————————————————————————————————————————————————————————————————————————————————— Limit
A
*  The height of point A and point B are both the same as Limit.
A B
fffffffffffffffffffffff Limit

*  Point A and point B are both lower than Limit, but the height that the height of point A
plus Height and that of point B plus Height is higher than Limit.

2.3.4.3 ARC Mode (ARC)

The trajectory of ARC mode is an arc, which is determined by three points (the current point,
any point and the end point on the arc), as shown in Figure 2.9.

ANOTICE

In ARC mode, it is necessary to confirm the three points with other motion modes, and
the three points cannot be in a line.

Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
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(@) Starting poini:A and end point ©

(b} Starting poini:A and end point B

Figure 2.9 ARC mode

2.3.4.4 CIRCLE Mode (CIRCLE)

The CIRCLE mode is similar to ARC mode, of which the trajectory is a circle. In CIRCLE
mode, it is necessary to confirm the three points with other motion modes.

2.3.4.5 Application Scenarios

The application scenario depends on the trajectory in motion mode, as shown in Table 2.1.

Table 2.1 Application scenario

Motion mode Application scenario

MOVL If the trajectory of playback is required as a
straight line, you can choose MOVL

MOV If the trajectory of playback is not required but
high speed is required, you can choose MOV

JUMP If the movement of two points is required to lift
upwards by amount of height, such as sucking
up, grabbing, you can choose JUMP

ARC If the trajectory of playback is required as an
arc, such as dispensing, you can choose ARC

CIRCLE If the trajectory of playback is required as a
circle you can choose CIRCLE

2.4 Technical Specifications

241 Technical Parameters

Name Dobot M1

Reach 400mm

Payload 1.5kg

Maximum Type Mechanical limitation Software limitation

Issue V1.0.4 (2018-08-30)
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magnitude

Rear arm -90<=90° -85 85°
Forearm -1352135° -135<135°
Z-axis screw Omm- 250mm 10mm- 235mm
End-effector -360< 360° -360< 60°
rotation

Maximum speed Joint speed of | 1807s
Forearm and
Rear Arm
Resultant 2000mm/s
speed of the
Forearm and
Rear Arm
Speed of Z- 1000mm/s
axis

Repeatability 0.02mm

Power Power Adapter: 100V-240V AC,50/60Hz
Dobot M1: 48V DC
System Linux

Communication

Ethernet, RS-232C

interface
110 . 22 digital outputs
. 24 digital inputs
o 2 DAC outputs, reserved
. 6 ADC inputs
Software M1Studio
LONOTE
Mechanical Limitation: Limit the position of Dobot M1 by mechanical parts.
Software Limitation: For protection, limit the position of Dobot M1 by software.
242  Sizes

Figure 2.10 show the size of Dobot M1.

LAONOTE

Z-axis Motion Range shown in Figure 2.10 indicates the mechanical limitation.
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641 mm

h 4

A

200 mm

550 mm

Mechanical Limitation
250 mm

687 mm
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Figure 2.10 Size of Dobot M1
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3. Hardware Installation

3.1 Environment Requirements

The operating temperature of Dobot M1 ranges from 5 <T to 40 <C. The operating humidity
ranges from 45% to 75% (non-condensing).

3.2 Installing the Base of Dobot M1

The stability of Dobot M1 depends on the installation of the base of Dobot M1. You can design
the platform according to the size of the hole of the base and the real environment for fixing Dobot
M1. The platform must not only bear Dobot M1, but also bear the dynamic force by the maximum
acceleration. Note the following before installing the platform.

*  Design the platform according to the workspace of Dobot M1, and ensure that Dobot M1
moves without interference.

*  Keep the platform level which is used to support Dobot M1.

* Do not put water or other drinks near or on the platform, in order to avoid potential safety
hazard because of liquid leakage.

Procedure

Step1  Check the packaging of Dobot M1, and confirm that the contents of the box are
consistent with the packaging list.

Step 2 Open the holes on the work platform according to the size of the hole of the base.
Figure 3.1 shows the size of hole of the base.

230

215

160 27.5

/OGN

Mauos punolb oy sjoy Bununopy

01l
G erl
GL1

Figure 3.1 Size of the base
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Step3 Move Dobot M1 to the platform, align the base of Dobot M1 with the holes, and then
use the hexagon wrench and six M6 bolts to fix Dobot M1.

3.3 (Optional) Installing End Effector

You can install the matching gripper, suction cup, or laser on the end effector of Dobot M1 for
transporting, intelligent sorting and laser engraving. Figure 3.2 shows the size of the end effector of
Dobot M1.

N A=A
e o] v = =
=
ﬂ
| 12
10
0.8 0.8 A
16
68
Figure 3.2 Size of the terminal
3.31 Installing Laser Engraving Kit
Figure 3.3 shows the laser Kit.
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Figure 3.3 Laser kit

Procedure
Step 1  Install the laser kit on the end effector and tighten the screws of the laser kit using
2.5# hexagon wrench.
Step2 Connect the connector of the laser kit to the Forearm I/O interface, as shown in

Figure 3.4,

Figure 3.4 connect to Forearm /O interface
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3.3.2 Installing 3D Printing Kit

Figure 3.5 shows the 3D printing kit.

Figure 3.5 3D printing kit

Procedure
Step1 Install the 3D printing kit on the end effector to make the printing head and Forearm
in a straight line and tighten the screws of the 3D printing kit using 2.5# hexagon
wrench.
Step 2 Connect the connector of the 3D printing kit to the Forearm I/O interface, as shown
in Figure 3.6.

Figure 3.6 Connect to Forearm I/O interface
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Step3 Install 3D printing filament. Please prepare the filament.

Press down the lever on the extruder by hand, and push down the filament to the
bottom via pulley, as shown in Figure 3.7 and Figure 3.8.
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Figure 3.8 Push down the filament (2)

3.4 (Optional) Installing Air Pump

It is necessary to install the matching air pump when using the gripper or suction cup for
grabbing objects. The air pump is controlled over the 1/0 interface. For details, please see 6.7
Operating I/O Assistant. The Air pump that we provided is used for debugging I/O interface.
In real applications, please select a professional one.
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Figure 3.9 shows the air pump. Table 3.1 lists the description of the cables that are shown
in the yellow box of this figure.

1)

\

Figure 3.9  Air pump

Table 3.1 Cable Description

Color Description

Red VCC_24V

Black PGND

Yellow OUT1: Control the intake and outtake of the air pump
Blue OUT2: Control the status of the air pump

If the air pump is connected to the base 1/O interface. The yellow cable and the blue one are
connected to the output pins (The corresponding outputs listed in 4.3.2.2 Base 1/O Interface are
DOUT17 and DOUT18) of the base 1/O interface. The red one and the black one are connected to
the VCC_24V pin on the base I/O interface and the PGND pin on the CAN bus interface
respectively, as shown in Figure 3.10, and you need to tighten them with a straight screwdriver. The
description in this topic is for reference only. Please choose the appropriate interface to connect the
air pump. For details, please see 4.3 Interface Description.
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Figure 3.10 Air pump connection

ANOTICE

When air pump is connected to 1/O interface, the terminals of air pump cannot be exposed
to the air, to avoid short circuit. For matching all 1/O interfaces, terminals of air pump
will be slightly longer. If that happens, you need to cut them to an appropriate length.
Figure 3.11 and Figure 3.12 show the standard and non-standard connection of the

terminals respectively.

Figure 3.11 Standard connection
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Figure 3.12 Non-standard connection
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4. Electrical Specifications

The address of the 1/O interfaces of Dobot M1 are unified.

4.1 Interface Board

The interface board of Dobot M1 is located on the back of the base, as shown in Figure 4.1.
Table 4.1 shows the function description.

®

®

®
®

©) ®

Figure 4.1 Interface board of Dobot M1

Table 4.1 Description of the interface borad

No. Description

1 Power button of Dobot M1

2 CAN interface

3 RS-232C interface

4 I/0 interface of the base

5 Teaching device interface, reserved
6 USB HOST interface, reserved
7 Ethernet interface

8 External expansion interface

9 External power interface

10 LED indicators

1 Reserved interface

4.2 LED Indicators
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Table 4.2 lists the status of the LED indicators on the interface board and the external power
box

Table 4.2 Description of the LED indicators

Iltem Description

External power box | The LED indicator is steady on when the external power box is powered on.

indicator

System indicator . All the LED indicators are off when Dobot M1 is powered off

. Yellow LED indicator: when powering on, the yellow LED indicator in the
base is steady on for about 15 seconds, and then blinks once. It is steady on
again for about 5 seconds

. Green LED indicator: when powered on, the yellow LED indicator in the base
is off, the green one is steady on for about 5 seconds, and then is blinking.
That means, Dobot M1 is in service

. Blue LED indicator: The blue one is blinking, indicating that Dobot M1 is

working in offline mode

. Red LED indicator: The red one is steady on, indicating that an alarm is
generated when Dobot M1 is running

4.3 Interface Description

ANOTICE

In this topic, PGND indicates the reference ground corresponding to 24V, AGND
indicates the reference ground corresponding to analog signal, and GND indicates the
reference ground corresponding to all signals.

4.3.1 Power Adapter Interface

4.3.1.1 AC Input Interface

ANOTICE

Figure 4.2 shows the power adapter. For details on how to connect Dobot M1 to power
adapter, please see 5.2 Connecting Power Supply.
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Figure 4.2 Power adapter

Table 4.3 The power adapter input interface description

No. Name Function Voltage/Current

1 AC_L L of the AC power 100V-240V AC/2.6A
2 AC_N N of the AC power 100V-240V AC/2.6A
3 GND GND GND

4.3.1.2 DC output Interface

Table 4.4 The power adapter output interface description

No. Name Function Voltage/Current
1 A+ Positive electrode of the DC | 48V DC/5A
power
2 A- Negative electrode of the DC | GND/5A
power

4.3.2 Body I/O Interface

ANOTICE

The current of the digital output supports 2mA without additional power, whereas the
maximum current of the digital output supports 3A with additional power.
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4.3.2.1 Power Interface

Table 4.5 Description of the power interface

PIN Name Function Voltage/Current
1 VIN Positive electrode of the DC | 48V DC/5A
power
2 GND Negative electrode of the DC | GND/5A
power
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4.3.2.2 Base l/O Interface

Table 4.6 Description of the base 1/O interface

PIN Name Function Voltage/Current
1 PGND Negative electrode of the logic | GND/2A
power
2 VCC Positive electrode of the logic | 24V DC/2A
power
3 RS232_RX RS232 acception RS232 level
4 RS232_TX RS232 transmission RS232 level
5 STOP2+ Positive electrode of the safety | 0V,24V/<100mA
input 2, used for connecting to
emergency stop switch
6 STOP1+ Positive electrode of the safety | 0V,24V/<100mA
input 1, used for connecting to
emergency stop switch
7 STOP2- Negative electrode of safety | 0V,24V/<100mA
input 2, used for connecting to
emergency stop switch
8 STOP1- Negative electrode of safety | 0V,24V/<100mA
input 1, used for connecting to
emergency stop switch
9 DOUT17 Digital output 0V,24V2mA
10 DOUT18 Digital output 0V,24/2mA
11 DIN_20 Digital input 0V,24V/<100mA
12 DIN_18 Digital input 0V,24V/<100mA
13 DIN_19 Digital input 0V,24V/<100mA
14 DIN_17 Digital input 0V,24V/<100mA
Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
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4.3.2.3 CAN Bus Interf

ace

Table 4.7 The CAN bus interface description

PIN Name Function Voltage/Current

1 VBUS Positive of VBUS 48V/5A

2 GND Negative of VBUS GND/5A

3 CAN1_H CAN bus CAN level

4 CANL1 L CAN bus CAN level
4.3.2.4 Forearm I/O Interface

Table 4.8 The Forearm I/O interface description

PIN Name Function Voltage/Current
1 VCC Positive electrode of the logic | 24V/2A

power
2 DOUT19 Digital output 0V,24VI2mA
3 DOUT20 Digital output 0V,24VI2mA
4 DOUT21 Digital output 0V,24VI2mA
5 DOUT22 Digital output 0V,24VI2mA
6 AING6 Analog input 0V-12V/<100mA
7 AIN7 Analog input 0V-12V/<100mA
8 AGND Negative electrode of the logic | AGND/1A

power
9 RS485_A RS485A bus RS485 RS485 level
10 RS485 B RS485B bus RS485 RS485 level
11 DIN21 Digital input 0V,24V/<100mA
12 DIN22 Digital input 0V,24V/<100mA
13 DIN23 Digital input 0V,24V/<100mA
14 DIN24 Digital input 0V,24V/<100mA
15 GND Negative electrode of the logic | GND/2A

power

4.3.3  External Expansion Interface
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Table 4.9 The external expansion interface description

PIN Name Function Voltage/Current

1 Al- Inversion signal input for A | RS422 level
phase of external encoderl

2 Al+ Signal input for A phase of | RS422 level
external encoderl

3 DIN1 Digital input 0V,24V/<100mA

4 DIN4 Digital input 0V,24V/<100mA

5 DIN3 Digital input 24V/<100mA

6 AOUT2 Analog output, reserved 0V~10V/10mA

7 CAN2_H CAN bus CAN CAN bus

8 DIN6 Digital input 0V,24V/<100mA

9 DIN5 Digital input 0V,24V/<100mA

10 AIN2 Analog input 0V-10V/<100mA

11 AIN3 Analog input 0V-10V/<100mA

12 DIN7 Digital input 0V,24V/<100mA

13 DIN10 Digital input 0V,24V/<100mA

14 DIN9 Digital input 0V,24V/<100mA

15 DIN12 Digital input 0V,24V/<100mA

16 FPGA_DOUT6 Digital output 0V,24VI2mA

(DOUT16)
17 FPGA_DOUT5 Digital output 0V,24VI2mA
(DOUT15)

18 DIN11 Digital input 0V,24V/<100mA

19 DIN14 Digital input 0V,24V/<100mA

20 DIN13 Digital input 0V,24V/<100mA

21 DIN15 Digital input 0V,24V/<100mA

22 B1+ Signal input for B phase of | RS422 level
external encoderl

23 B1- Inversion signal input for B | RS422 level
phase of external encoderl

24 DOUT2 Digital output 0V,24VI2mA
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PIN Name Function Voltage/Current
25 DOUT1 Digital output 0V,24VI2mA
26 DIN2 Digital input 0V,24V/<100mA
27 DOUT4 Digital output 0V,24VI2mA
28 DOUT3 Digital output 0V,24VI2mA
29 CAN2_L CAN bus CAN level
30 DOUT5 Digital output 0V,24VI2mA
31 DOUT7 Digital output 0V,24VI2mA
32 DIN8 Digital input 0V,24V/<100mA
33 AIN4 Analog input 0V~10V/<100mA
34 FPGA_DOUT2 Digital output 0V,24VI2mA
(DOUT12)
35 FPGA_DOUT4 Digital output 0V,24V/I2mA
(DOUT14)
36 FPGA_DOUT3 Digital output 0V, 24V/2mA
(DOUT13)
37 DIN16 Digital input 0V,24V/<100mA
38 PGND Negative of the logic power GND/5A
39 PGND Negative of the logic power GND/5A
40 VCC Positive of the logic power 24VI3A
41 VCC Positive of the logic power 24VI3A
42 VCC Positive of the logic power 24VI3A
43 B2- Inversion signal input for B | RS422 level
phase of external encoder2
44 B2+ Signal input for B phase of | RS422 level
external encoder2
45 A2+ Signal input for A phase of | RS422 level
external encoder2
46 A2- Inversion signal input for A | RS422 level
phase of external encoder2
47 RS_485 A RS485A bus RRS485 level
48 RS_485 B RS485B bus RS485 level
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PIN Name Function Voltage/Current

49 AOUT1 Analog output, reserved 0V-10V/10mA

50 DOUT6 Digital output 0V,24VI2mA

51 DOUTS8 Digital output 0V,24VI2mA

52 AIN1 Analog input 0V-10V/<100mA

53 DOUT10 Digital output 0V,24VI2mA

54 DOUT9 Digital output 0V,24VI2mA

55 FPGA_DOUT1 Digital output 0V,24VI2mA
(DOUT11)

56 GND Negative of the analog power GND/1A

57 PGND Negative of the logic power GND/5A

58 PGND Negative of the logic power GND/5A

59 PGND Negative of the logic power GND/5A

60 ON_OFF- Negative of the power signal 0V-24V/<100mA

61 ON_OFF+ Positive of the power signal 0V-24V/<100mA

62 VCC Positive of the logic power 5VI2A

4.3.4 Communication Interface
4.3.4.1 Ethernet Interface

Dobot M1 can connect to a PC over standard RJ45 Socket interface, using TCP/IP.
4.3.4.2 RS-232C Interface

Dobot M1 can connect to a PC over standard RS-232C interface.
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5. Installation and Commissioning

5.1 Installing Software

The main software for Dobot M1 is M1Studio. You can use playback, script control, 3D
printing, etc.

511 Environment Requirements

The supported OSs are as follows.

e Win7
e Win8
e Winl0

5.1.2  Obtaining M1Studio Software Package

Before operating Dobot M1, please download the correct version of M1Studio. The path is
www.dobot.cc/downloadcenter/dobot-m1.html#most-download.

513 Installing M1Studio

Prerequisites

You have obtained the M1Studio software.
Procedure

Step1  Decompress the M1Studio software,

If the directory containing decompressed M1Studio files is E:\M1Studio. Please
replace the directory based on site requirements.

Step 2 Double-click M1Studio.exe in the E:\M1Studio directory.
The Select Setup Language page is displayed

Step3  Choose the installation language based on site requirements.

Step 4  Click Next.

Step5  Click Browse... to choose the installation path of M1Studio on the Setup-M1Studio
page, and click Next.
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) Setup - DobotStudio —

Select Destination Location
Where should DobotStudio be installed?

Setup will install DobotStudio into the following folder,

To continue, dick Next. If you would like to select a different folder, dick Browse.

|C: \Program Files'\DobotS tudio| Browse. ..

At least 558.9 MB of free disk space is required.

< Back Cancel

Figure 5.1 The M1Studio installation GUI

Step 6  Select Create a desktop shortcut and click Next.
Step 7  Click Install.

After 40 seconds later, the DriverSetup(X64) page is displayed.
Step 8 Click INSTALL on the DriverSetup(X64 page.

The Driver install success! dialog box is displayed, which indicates that the
installation of M1Studio driver is successful.

Step 9  Click Next on the Setup-M1Studio page.
Step 10 Click Finish.

514  Verifying Installation

Please double-click M1Studio after installation. If M1Studio can be started, the installation is
successful.

51.5 Troubleshooting

If M1Studio is not running, you need to install all VC++ libraries in the C:\Program
Files\M1Studio\attachment directory, as shown in Figure 5.2.

C:\Program Files\M1Studio indicates the installation directory of M1Studio, please replace
the installation directory based on site requirements.
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Windows 10 (C) » Program Files » DobotStudio » attachment

~oER skl =3 Fh

2dModeStl 2017/9/18 11:25 el

CH341SER_WIN 2017/9/18 11:25 i

grbrMode 2017/9/18 1125 Sefse

Slie3r 2017/9/18 1125 Srffse
Dobet 2.0 Vassini 2017/8/919:32  EEES 3 KB
Dobet 2.0.ni 2017/8/9 1932 EEES 3KB
Dobet-2.0 Vase-Curadni 2017/8/2 1932 EEEE 11K8
Dobot-2.0-Cura.ini 2017/8/9 19:32 EEEE 11 KB
B Dobotstudio_dll_X64.exe 2017/8/9 19:32 e 1,896 KB
B DobotStudio_dil_X86.exe 2017/8/0 1932 REES 1719 K8
& Repetier].0.6ireg 2017/8/919:32  EHEM 13K8
slic3r.bat 2017/8/919:32  Windows H#hE.. 1KB

Efl ve2010 x64.exe 2017/8/9 19:32 RIS 5,585 KB
Ffl ve2010 x86.exe 2017/8/919:32  RiEIEF 4,955 KB
1 ve2013 x6d.exe 2017/8/9 1932  ReFIEF 7,027 KB
1 vc2013 xB6.exe 2017/8/919:32  ReFIEF 6,353 KB
18 vez015.x64.exe 2017/8/9 1932 RCAIEE 14,944 KB
18 vc2015.x86.exe 2017/8/9 1932 RIFIRE 14,119 KB

Figure 5.2 The VC++ libraries

5.2 Connecting Power Supply

Figure 5.3 shows the power supply cables and power adapter. No.1 in Figure 5.3 indicates
power supply output cable, No.2 indicates power supply input cable, and No.3 indicates power
adapter.

Figure 5.3 Power cables and power adapter
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The input and output interfaces of the power adapter are shown in Table 5.1 and Table 5.2.sS

Table 5.1 The power adapter input interface description

No. Name Function Voltage/Current
1 AC L L of the AC power 100V-240V AC/2.6A
2 AC_N N of the AC power 100V-240V AC/2.6A
3 GND GND GND
Table 5.2 The power adapter output interface description

No. Name Function Voltage/Current
1 A+ Positive electrode of the DC | 48V DC/5A

power
2 A- Negative electrode of the DC | GND/SA

power

Procedure

Step1 Connect the yellow-green cable on one end of the power supply input cable to the
GND pin on the power adapter, the blue one to the N pin and the brown one to the L
pin. Tighten them with a cross screwdriver, as shown in Figure 5.4. If you cannot

connect, please loosen the cage clamp firstly with the cross screwdriver.
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Figure 5.4 Connect power supply input cable to power adapter

ANOTICE

If the type of the power input supply is America-standard, please connect the G pin on
the power input supply to the Ground pin on the power adapter, the W pin to the N pin,
and the Z pin to the L pin.

Step 2 Connect the red cable on one end of the power supply output cable to the A+ pin on
the power adapter, the black one to the A- pin. Tighten them with a cross screwdriver,
as shown in Figure 5.5. If you cannot connect, please loosen the cage clamp firstly
with the cross screwdriver.
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Figure 5.5 Connect power supply output cable to power adapter

Step3  Connect the other end of the power supply output cable to the power interface on the
base of Dobot M1, as shown in Figure 5.6.

Figure 5.6 Connect to Dobot M1
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Step 4  Connect the other end of the power supply input cable to the 220V AC socket.

5.3 Connecting Emergency Stop Switch

Before operating Dobot M1, please connect it to the emergency stop switch to ensure that
Dobot M1 can be stopped immediately during running.

When powering on for the first time, please ensure that the emergency stop switch has been
opened (The emergency stop button is bumped). Otherwise, the robotic arm will not work normally.
If the emergency stop switch is not opened, please rotate the emergency stop button clockwise. The
emergency stop button will be bumped when rotating to 45<

Procedure

Please connect the terminal block connector with the emergency stop switch to the base I/O
interface, and you need to tighten the terminal block connector with a straight screwdriver as shown
in Figure 5.7 and Figure 5.8.

Figure 5.7 Connection between Dobot M1 and the emergency stop switch (1)

Figure 5.8 Connection between Dobot M1 and the emergency stop switch (2)
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5.4 Connecting External Cables
541 Connecting Serial Port

Prerequisites

Please prepare USB to serial line. One end is standard USB port, the other end is 9-pins serial
port.

Procedure

Step1  Connect the serial port of the USB to serial line to the serial port of the base, as shown
in Figure 5.9.

Figure 5.9 The serial port connection

Step 2 Connect the USB port of the USB to serial line to the USB port of the PC.

After startup, you can check the corresponding serial information from the serial
drop-down list on the upper left pane of the M1Studio page.

Figure 5.10 The serial information of M1Studio

54.2  Connecting Network Cable

You can connect Dobot M1 to a PC over a network cable.

Prerequisites
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You have connected the PC to a router.

Procedure

ANOTICE

*  Thistopic describes how to connect a PC to Dobot M1 using a router. It is applicable
to the scenario in which robotic arms are connected to the same PC. If only one
robotic arm is connected to the PC, you can connect robotic arm to the PC directly
using the network cable without router.

e  Ifyou connect Dobot M1 to a PC over a network cable, the IP address of them must
be on the same network segment without conflict. You need to set IP address of
Dobot M1 or that of the PC after connecting Dobot M1 to the PC. For details, please
see 5.5.3 Setting IP Address.

Step 1  Connect one end of the network cable to Ethernet port at the base of Dobot M1.

Step 2 Connect the other end of the network cable to the router or the switch that is on the
same LAN as the PC.

5 seconds after startup, you can check the corresponding IP information from the
serial drop-down list on the upper left pane of the M1Studio page.
5.5 System Commissioning

The origin and other settings of Dobot M1 have been set by default, Dobot M1 can be directly
put in use. After Dobot M1 is installed and the cables connected are checked, the system
commissioning can be performed.

551 Debugging Dobot M1

Prerequisites
*  You have started M1Studio.
*  You have connected Dobot M1 to the PC over a serial cable.
*  (Optional) You have connected Dobot M1 to the PC over a network cable.
*  You have connected Dobot M1 and an emergency stop switch.
Procedure

Step1  Start Dobot M1. Hold down the power button in the base of Dobot M1 for about 2

seconds, and then release your fingers when the yellow LED indicator is on.

When powering on, the yellow LED indicator in the base is steady on for about 15
seconds, and then blinks once. It is steady on again for about 5 seconds, which
indicates that Dobot M1 is being started.

After the yellow LED indicator in the base is off, the green one is steady on for about
5 seconds, and then is blinking, which indicates that Dobot M1 is in service.

ANOTICE

When first powering on robotic arm, please check Z-axis or J3 value from M1Studio. If
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the value is below 10mm, an alarm about limitation is generated and meanwhile the red
indicator on the base of robotic arm is on, which is a normal phenomenon. At that point,
you need to click J3+ under Joint coordinate system to jog robotic arm to the position
where the J3 value is above 10mm, and then the alarm will be cleared.

Step2  Select the corresponding serial port from the serial drop-down list, and click
Connect.

If Connect turns to Disconnect, the connection is successful, and Dobot M1 can be
controlled by M1Studio.

yotStudio-V1.0.3RC

Tools  Help

COMLZ

Figure 5.11 The successful Connection

ANOTICE

* You can connect Dobot M1 to a PC over a network cable, then select the
corresponding IP address from the serial drop-down list on the M1Studio page and
click Connect. The IP address of Dobot M1 and the PC must be on the same
network segment. If not, please see 5.5.3 Setting IP Address to modify the IP
address.

e M1Studio can be connected to Dobot M1 only when Dobot M1 is in Dobot Mode.
You can check the current mode of Dobot M1 on the Tools > Web Management
page, as shown in Figure 5.12. For details, please see 6.8 Operating Web
Management.

# Home
# DobotM1 w

File Management The web manager of Dobot M1 integrates offline file management, firmware update, application update, and so on.

Mode Switch Controlling

Dobot Mode ~

Update Management

ER Update Firmware

Test Management

Figure 5.12 Status of Dobot M1
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552 Debugging the Power of Dobot M1

Prerequisites

*  You have powered on Dobot M1.

*  You have connected Dobot M1 and an emergency stop switch.
Procedure

Hold down the power button in the base of Dobot M1 for about 5 seconds, and then release
your fingers. If all LED indicators are off and Dobot M1 moves down automatically, Dobot M1 is
powered off successfully.

ANOTICE

You cannot hold down the power button to power off Dobot M1 until Dobot M1 is in the
running state (when the green LED indicator is blinking). If Dobot M1 fails to be started,
you must force to power off Dobot M1.

5.5.3  Setting IP Address

Prerequisites
*  You have started M1Studio.
*  You have connected Dobot M1 to the PC over a serial cable.
*  You have connected Dobot M1 to the PC over a network cable.
*  You have powered on Dobot M1.
*  You have connected Dobot M1 and an emergency stop switch.
5.5.3.1 Checking the IP Address of Dobot M1

Step1  Select the corresponding serial port from the serial drop-down list on the upper left
pane of the M 1Studio page and click Connect.

If Connect turns to Disconnect, the connection is successful.
Step 2 Select Tools > IP Address Setting on the M1Studio page.
The Dobot M1 IP Address Setting is displayed.
Step3  Click Reload, you can check the IP address of Dobot M1, as shown in Figure 5.13.
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Dobot M1 IP Address Setting

Network Status of ot M1: Connected to LAN

@ Dynamic Host Configuration P (DHCP)

IP Address
Metmask

Gateway

Reload Confirm

Figure 5.13 IP address of Dobot M1

5.5.3.2 Changing the IP Address of Dobot M1

ANOTICE

e If you connect Dobot M1 to a PC over a network cable directly, you need to set IP
address and subnet mask of Dobot M1. The IP address of Dobot M1and the PC must
be on the same network segment without conflict. The subnet masks of them must

be the same.

e If you connect Dobot M1 to a PC over a router and select Dynamic Host
Configuration Protocol (DHCP), you can use dynamic IP address directly without

configuration.

e If you connect Dobot M1 to a PC over a router and unselect Dynamic Host
Configuration Protocol (DHCP), you need to set IP address, subnet mask and
gateway of Dobot M1 to make Dobot M1 and the PC on the same LAN.

If Dobot M1 is directly connected to the PC over the network cable, the local IP address, subnet
mask of the PC are 10.10.1.10, 255.255.255.0 respectively. You can run the command ipconfig /all

on the CMD console window to view the IP information of the PC.

Step 1

Step 2

Step3 Change IP Address and Netmask on the Dobot M1 IP Address Setting page.
Step4  Click Confirm.
If Network Status of Dobot M1 turns to Connected to LAN, the modification is
successful.
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Select the corresponding serial port from the serial drop-down list on the upper left

pane of the M1Studio page and click Connect.

If Connect turns to Disconnect, the connection is successful.
Select IP Address Setting on the M 1Studio page.

The Dobot M1 IP Address Setting page is displayed.
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Step5  Click Disconnect on the upper left pane of the M 1Studio page.
If Disconnect turns to Connect, Dobot M1 is disconnected from the PC.

Step 6  About 2 seconds later, select the modified IP address from the drop-down list on the
upper left pane of the M 1Studio page, and click Connect,

If Connect turns to Disconnect, the connection by the network cable is successful.
5.5.3.3 (Optional) Changing the IP Address of the PC

You can change the IP address of the PC to make it on the same network segment as that of
Dobot M1.

LONOTE

This section uses Win7 OS as an example to describe how to change the IP address.
Please change it based on site requirements.

Step1 Check the IP address of Dobot M1, for details, please see 5.5.3.7 Checking the IP
Address of Dobot M1,

Step 2 Click Start > Control Panel on the PC and select Network and Sharing Centre,
The Network and Sharing Centre page is displayed.

Step3  Click Local Area Connection on the Network and Sharing Center page.

Step 4  Click Properties.
Double-click Internet Protocol Version 4(TCP/IPv4).

Step S  Select Use the following IP address, and change the IP address, subnet mask, and
gateway of the PC.

You can change the IP address of the PC to make it on the same network segment as
that of Dobot M1 without conflict. The subnet mask and gateway of the PC must be
the same as that of Dobot M1.

ANOTICE

If the PC is connected to Dobot M1 over a network cable directly, you only need to set
the IP address and subnet mask of the PC.
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Internet BHURRES 4 (TCP/IPv4) Properties x
General

¥ou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask yvour network administrator
for the appropriate IP settings.

() Obtain an IP address automatically
(®) Use the following IP address:

IF address: | . . . |

Subnet mask: | . . . |

Default gateway: | . . . |

Obtain DNS server address automatically

(@) Use the following DNS server addresses:

Preferred DMS server: | . . . |

Alternative DNS server: | . . . |

[ ] validate settings upon exit o ——

Cancel

Figure 5.14 IP address modification

Step 6 Click OK.
Step 7  Click Disconnect on the left pane of the M 1Studio page.
If Disconnect turns to Connect, Dobot M1 is disconnected from the PC.

Step 8  Select the corresponding IP address from the drop-down list on the upper left pane
of the M1Studio page, and click Connect.

If Connect turns to Disconnect, the connection by the network cable is successful.
554  Debugging Emergency Stop Function
Prerequisites
*  Dobot M1 has been powered on.
*  Dobot M1 has been connected to a PC successfully.
*  Dobot M1 has been connected to an emergency stop switch.
Procedure

Step1 Make Dobot M1 in the running state. For details, please see 6.2 Operating Teaching
and Playback.

Step2 Hold down the emergency stop button, to make Dobot M1 in the stopped status, as
shown in Figure 5.15.
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Figure 5.15 Emergency stop

Dobot M1 is stopped immediately with an alarm about emergency stop and the red
LED indicator on the base is on, which indicates that the emergency stop function is
OK.

Step3  Rotate the emergency stop button clockwise.

The emergency stop button is bumped when rotating to 45° , which indicates the
stopped status is cleared.

Step 4  Double-click the alarm tip generated on the M1Studio page, as shown in Figure 5.16
The Alarm and Log page is displayed.

Figure 5.16 Alarm tip

Step 5 Click Reboot on the Dobot M1 Alarm tab of Alarm and Log page to Restart Dobot
M1, as shown in Figure 5.17.

If Dobot M1 can be running after rebooting, the stopped status is cleared successfully.
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© Alarm and Log

Dobot M1 Alarm Operation Log

Alarm List
History - Auto Scroll

Description Cause

Dobot M1 is in the stoped status. Hold down the emergency stop
button, leading to a result that
Dobot M1 is in the stopped status.

Measure

1. Rotate the emergency stop button clockwise to clear the stopped status.
It will be bumped when rotating to 45°.

2. Click "Reboot" on the AlarmLog page to make Dobot M1 in the working
status.

Reboot Clear Alarm Quit

Figure 5.17 Alarm tab

555 Debugging Motion Function

For details about motion functions supported by Dobot M1, please see 2.3.4 Motion Function.
5.5.5.1 Debugging Jogging Function
Prerequisites

*  Dobot M1 has been powered on.

*  Dobot M1 has been connected to a PC successfully.

*  Dobot M1 has been connected to an emergency stop switch.
Procedure

This section uses Cartesian coordinates as an example to describe how to debug jogging
function. The procedure for debugging Joint coordinates is similar to that for debugging Cartesian
coordinates. You need to select Joint on the Operation Panel page, and then Click J1+, J1-, J2+,
J2-, J3+, J3-, J4+, and J4- to jog Dobot M1.

Step1  Select Cartesian from Cartesian drop-down list on the Operation Panel page.

The Cartesian coordinate pane is displayed.

Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
47




0 DoBOT Dobot M1 User Guide 5 Installation and Commissioning

Operation Panel

Joint1
Joint2
Joint3

Jointd

Motor: Power:

Figure 5.18 Cartesian coordinate mode

Step2  Drag the Vel slider on the Operation Panel page to change the velocity ratio of the

movement when implementing jogging.
The jogging velocity is the maximum velocity multiplying the corresponding
percentage.

Step3  Drag the Acc slider on the Operation Panel page to change the acceleration ratio of
the movement when implementing jogging.
The jogging acceleration is the maximum acceleration multiplying the corresponding
percentage.

Step4 Click X+ on the Operation Panel page to make Dobot M1 jog along X-axis in the
positive direction. Click X~ to make Dobot M1 jog along X-axis in the negative

direction.

You can click Y+, Y-, Z+, Z-, R+, and R-, to make Dobot M1 jog along Y, Z, or R in
the negative or positive direction.

5.5.5.2 Debugging Playback Function

Prerequisites
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*  Dobot M1 has been powered on.

*  Dobot M1 has been connected to a PC successfully.

*  Dobot M1 has been connected to an emergency stop switch.
Procedure

This section uses MOVL mode as an example to describe how to debug playback function.
You can choose other modes such as MOVL, MOVJ, ARC, or CIRCLE. For details on how to save
point in ARC and CIRCLE mode, please see 6.1.3 Saving Point in ARC Mode.

Step1 Jog Dobot M1 to a point according to 5.5.5.1 Debugging Jogging Function.
Step 2 Select Playback on the DobotStudio page.
The Playback page is displayed.
Step 3  Select PTP > MOVJ on the Add Motion Command pane of the Playback page.
Step 4  Seclect Add At Last on the Playback page.

Step5  Set Vel and Jerk on the Add Motion Command pane of the Playback page, and
click Add Motion Command to save the point at Step 1.

Vel and Jerk on the Playback page indicate the velocity ratio and the jerk ratio of
the movement when implementing playback respectively. The playback velocity is
the maximum velocity multiplying the corresponding percentage. The playback jerk
is the maximum jerk multiplying the corresponding percentage.

Step 6  Set the pause time of the previous command on the Add Wait Command pane of
the Playback page, and click Add Wait Command.

Step 7 Jog Dobot M1 to another point. And save it. For details, see Step 1 to Step 6.
Step 8  Click Start on the Playback page to make Dobot M1 move according to the saved
points list.

5.5.6  Debugging Disabling Function

You can disable the motor of Dobot M1 to make it in the open-loop state, and then move Dobot
M1 by hand.
Prerequisites

*  Dobot M1 has been powered on.

*  Dobot M1 has been connected to a PC successfully.

*  Dobot M1 has been connected to an emergency stop switch.

Procedure

Step1 Click the _ icon of Motor on the Operation Panel pane of the M1Studio

page, as shown in Figure 5.19.

Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
49




0 DoBOT Dobot M1 User Guide 5 Installation and Commissioning

Operation Panel
Joint1
Joint2
Joint3

Jointd

Cartesian v

Motor:

Figure 5.19 Disabling Dobot M1

If _ turns to - and Dobot M1 moves down automatically, the

motor of Dobot M1 is in the open-loop state.
Step2  Check whether Dobot M1 can be moved by hand.
If Dobot M1 can be moved by hand, the disabling function is OK.

5.5.7 Debugging Homing Function

After parts (motors, reduction gear units, battery, etc.) have been replaced or robotic arm has
hit the work piece, the origin of Dobot M1 will be changed. You need to set homing point after
resetting the origin.

Dobot M1 has installed homing switches near the J1, J2 and J3 limitation position respectively.
When Dobot M1 moves to the limit with a signal triggered by the homing switch, Dobot M1 will
move backward at low speed and stop moving after separating from the homing switch, which
indicates that Dobot M1 has moved to the homing point. At the same time, an alarm about limitation
is generated, you need to jog the Joint coordinate to clear the alarm.
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ANOTICE

Only Dobot M1 of which SN number is DT2018xxx has installed the homing switch.
You can view the SN number on the Help > About M1Studio page.

xxx indicates the random number, please replace it based on site requirements.

Prerequisites

e  Dobot M1 has been powered on.

*  Dobot M1 has been connected to a PC successfully.

*  Dobot M1 has been connected to an emergency stop switch.
Procedure

Please select Tools > Home on the M1Studio page, and Dobot M1 will move automatically
according to the following steppes.

Step1 J3 moves to the upper limit with a signal triggered by the homing switch, and moves
backward at low speed to separate from the homing switch, and then stops moving.

Step2 ]l and J2 move to the limit as lefty hand orientation with signals triggered by homing
switches of J1 and J2, and move backward at low speed to separate from the homing
switches, and then stop moving, indicating that Dobot M1 has moved to the homing

point, of which the coordinate is shown as Figure 5.20.

The coordinates shown in Figure 5.20 is for reference only, please replace it based

on site requirements.

Operation Panel

Joint1
|Joint2
Joint3

Jointd

Joint

Figure 5.20 Homing point
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6. Operation

6.1 Instructions for M1Studio

6.1.1

Module Description

Dobot M1 supports teaching, playback, script control, and Blockly graphic programming. You
can use M1Studio to control Dobot M1. Table 6.1 lists the corresponding applications on the
M1Studio page.

On the M1Studio page, the Playback and Script tab are opened by default. If you need to open
Blockly or 1/0O Assistant, please select the corresponding option on the Tools menu of the M1Studio

page.
Table 6.1 The module description of M1Studio GUI

Module Function

Playback Teach Dobot M1 how to move and then record the movement to make
Dobot M1 accomplish the recorded movements.

Blockly Control Dobot M1 by graphic programming. You can program through
a puzzle interface which is intuitive and easy to understand.

Script Control Dobot M1 by scripting language.

1/0 Assistant Debug the 1/0 interface that used

Web Management Execute the saved points lists in offline mode, and upgrade the
firmware.

6.1.2

Alarms Description

If teaching or saving point is incorrect, for example, Dobot M1 moves to where a point is at a
limited position or a singular position, Dobot M1 will generate an alarm. For details, please see
Table 6.2. When an alarm is generated, the red LED indicator on the base will be on.

ANOTICE

Singular point: If the directions of the jointl and joint2 are collinear, the resultant
velocity of jointl and joint2 is not in any direction, but in the direction of jointl
(joint2). Namely, the degrees of freedom of Dobot M1 are degraded. The singular
point is at the position where joint2 is located at +10< In JUMP and MOVJ mode,
the movement of Dobot M1 is joint movement, Dobot M1 will not generate an alarm
about singular point.

Generally, if you save a point where an alarm is generated when implementing
jogging, the saved point is unavailable. You need to jog Dobot M1 towards the
opposite direction under the Joint coordinate system to clear the alarm, and then
save the point. However, if an alarm about singular point is generated when
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implementing jogging, the saved point is available in JUMP and MOVJ mode.

* In MOVJ or JUMP mode, if the two points are the same, only different in arm

orientations, J1 or J4 may be limited when moving Dobot M1, resulting in an alarm
generated. You need to modify and resave the point for which the alarm is generated,
and then clear the alarm manually.

Table 6.2 Alarm Description

Alarm Condition

Clear method

Jogging

The Joint coordinate is limited

Jog the limited Joint coordinate towards the opposite
direction, and the alarm will be automatically cleared

The Cartesian coordinate is limited

Jog Joint coordinate towards the opposite direction, and
the alarm will be automatically cleared

The point is at the singular position when clicking
the Cartesian coordinate buttons

Jog joint2, and the alarm will be automatically cleared

Playback

The starting point or the end point is a singular point
in MOVL mode

Clear the alarm manually and modify the point

A point in the trajectory is a singular point in MOVL

mode

Clear the alarm manually and modify the point

Modify the arm orientation of the saved point in
MOVL mode

Clear the alarm manually and modify the arm orientation

The middle point or the end point is a singular point
in ARC mode

Clear the alarm manually and modify the point

A point in the trajectory is a singular point in ARC

mode

Clear the alarm manually and modify the point

Any two of the three points of the arc are coincided
in ARC mode

Clear the alarm manually and modify the point

The three points of the arc are in a line in ARC mode

Clear the alarm manually and modify the point

The trajectory is out of range of the workspace in all

modes

Clear the alarm manually and modify the point

The joint is limited in all modes

Clear the alarm manually and modify the point

The method how to clear the alarm is shown as follows.

Prerequisites

*  Dobot M1 has been powered on.
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*  Dobot M1 has been connected to the PC successfully.
*  Dobot M1 has been connected to the emergency stop switch.
Procedure
Step 1  Double-click the alarm tip on the M1Studio page, as shown in Figure 6.1.
The Alarm Log is displayed.

© DobotStudio-V1.0.3RC

Settings  Tools  Help

Figure 6.1 Alarm tips

Step 2 View the corresponding alarm on the Dobot Alarm tab. According to Measure to
clear the alarm, as shown in Figure 6.2.

2 Alarm and Log
Dobot M1 Alarm Operation Log

Alarm List

ERR_LIMIT_AXIS2_POS

The joint2 is at the positive limited The joint1 is at the negative limited
position. position.

Measure
Jog the joint2 towards the opposite direction and the alarm will be
automatically cleared.

Clear Alarm

Figure 6.2 Alarm GUI

ANOTICE

The button Reboot is available only when the alarm is generated about emergency stop.

Table 6.3 shows the description of the alarm button.
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Table 6.3 Alarm button description

Button Description

History Whether to display the historical alarms.

e |f the status of History is _ all

historical alarms will be displayed.

e If the status of History is _

only the current alarm will be displayed.

AutoScroll Whether to scroll the alarm information automatically

If the status of AutoScroll is _ the alarm

information will be scrolled automatically

Step3  Click Clear Alarm on the bottom pane of the Dobot M1 Alarm tab, as shown in
Figure 6.2.

If there are no alarm tips on the M1Studio page, the alarm have been cleared.
6.1.3  Saving Point in ARC Mode
Different from PTP, the trajectory of ARC is an arc, you need to save three points to complete
the arc trajectory. The method to save points in CIRCLE is the same as that of ARC.
Prerequisites
*  Dobot M1 has been powered on.
*  Dobot M1 has been connected to the PC successfully.

*  Dobot M1 has been connected to the emergency stop switch.

Procedure

ANOTICE

You need to use other motion modes to confirm the starting point of the arc trajectory,
because the middle point and the end point only can be confirmed in ARC mode. When
saving points in ARC, please pay attention to the following tips to avoid generating an
alarm.

. Any two of the three points of the arc cannot be coincided
*  The three points of the arc cannot be in a line.
*  The arc trajectory cannot be out range of the workspace

e The arm orientations in ARC and other mode that confirms the starting point should
be the same. Otherwise, Dobot M1 will not work.

If the three points of the arc trajectory are point A, point B, and point C respectively, and point
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A is the starting point, point C is the end point, as shown in Figure 6.3.

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

Figure 6.3 Arc trajectory

Select Cartesian from Cartesian drop-down list on the Operation Panel page, and
click the Cartesian coordinate buttons to jog Dobot M1 to a point called point A.
Select Playback on the M1Studio page.

The Playback page is displayed.

Select Add At Last on the Playback page.

Select PTP > MOVJ on the Playback page, and click Add Motion Command to
save point A,

Click the Cartesian coordinate buttons on the Operation Panel page to jog Dobot
M1 to another point called point B.

Select ARC > Transition Pos on the Playback page, and click Add Motion
Command to save point B.

Click the Cartesian coordinate buttons on the Operation Panel page to jog Dobot
M1 to another point called point C that is not coincided with point A and point B.
The three points are not in a line.

Click Add Metion Command to save point C.

A NOTICE

You cannot set the pause time when point A moves to point B. Otherwise, Dobot M1 will
not work.

Step 9  Click Start, and you will find that Dobot M1 moves as an arc. The information of
saved points in ARC is shown as Figure 6.4.
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Figure 6.4 Information of saved points in ARC

6.1.4  Saving point in JUMP Mode

From point A to point B in JUMP mode:
* If point Aand point B are only different in Z-axis, but the arm orientations of them are the
same, Dobot M1 will not work.

* If point A and point B are the same, only different in arm orientations, for example, the
arm orientation of point A is left, and that of point B is right, point A moves to point B as
the right hand posture, while the terminal coordinate relative to the origin stays constant.

6.2 Operating Teaching and Playback

Prerequisites
*  Dobot M1 has been powered on.
*  Dobot M1 has been connected to the PC successfully.
*  Dobot M1 has been connected to the emergency stop switch.

*  The air pump and the suction cup need to be installed when you suck up objects over
teaching and playback. For details on how to connect with air pump, please see 3.4
(Optional) Installing Air Pump.

Application Scenario

If you want to use Dobot M1 to transport, intelligent sort, write and draw, teaching and
playback functions of Dobot M1 can help you to complete. This section uses the suction cup as the
end effector to describe how to operate.

Procedure
Step1 Place a small object nearby Dobot M1, choose one of the following three methods to

jog Dobot M1 on the small object, called point A. The distance from Dobot M1 to
the object should be determined based on site requirements.

e Select Cartesian from Cartesian drop-down list on the Operation Panel page, and
click the Cartesian coordinate buttons.

e Select Joint from Cartesian drop-down list on the Operation Panel page, and click
the Joint coordinate buttons.
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e  Click the _ icon of Motor on the Operation Panel page, and jog Dobot
M1 by hand.

ANOTICE

e If you want to jog Dobot M1 by hand when implementing jogging, please click

_ to make the motor of Dobot M1 in the open-loop state. If you want to

move Dobot M1 by clicking the coordinate buttons on the Operation Panel page,

please click - to make the motor in the close-loop state.

e Ifanaxisis limited or a point is at the singular position when implementing jogging,
an alarm will be generated. For details about alarm description, please see Table
6.2 .If you save a point after an alarm is generated, the saved point is unavailable.
You need to jog Dobot M1 to clear the alarm, and then save the point again.
However, if an alarm about singular point is generated when implementing jogging,
the saved point is available in JUMP and MOVJ mode.

Step 2 Select Add At Last on the Playback page.
Step3  Select Playback on the M1Studio page.
The Playback page is displayed.

Step4  Select PTP > JUMP on the Playback page, as shown in Figure 6.5. The constraints
in JUMP mode are as shown in 6. /.4 Saving point in JUMP Mode.

LAONOTE

The motion mode in this topic is for reference only. You can choose other motion modes
based on site requirements. If you use ARC mode, for details on how to saving points in
ARC, please see 6.1.3 Saving Point in ARC Mode.

ARC Via(-132.4696, 151.4113, 1045000, 216.2315), Tof-128.5147, 154.7822, 104.5000, 214751

Add 10 Cc

Apply DynRatio

Figure 6.5 Choose motion mode
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Step5  Set the velocity ratio and the jerk ratio of the movement of when implementing
playback on the Add Motion Command pane of the Playback page, and click Add
Motion Command to save point A. If the values are both set to 50%.
The saved point information of which Type is JUMP is displayed on the left pane of
the Playback page, as shown in Figure 6.6.

To(-108.6345, 169.3284, 104,500, 207.7315), Height/Limit(20.0000, 200.0000), Vel/Jerk{50%, 50%), ArmOrientation{Right)

Via(-132.4696, 1514113, 104:5000, 216.2315), Tel(-128.5147, 154.7822, 104.5000, 214.7514), Vel/Jerk(30%, 30%), AmOrientation(Right)

Apply DynRatio

Figure 6.6 The coordinate display

You need to double-click contents displayed in Content to set the lifting height
(Height) and the maximum lifting height (Limit) on the current saved point line, of
which Type is JUMP, as shown in Figure 6.7.

2 Motion Command Setting

Height Limit 2

n Parameters
Vel 50 % Jerk

Arm Orientation
@Left ORight

Joint

/E+

A

Confirm

Figure 6.7 Motion command setting
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ANOTICE

In JUMP mode, if lifting Dobot M1 to the maximum height is not necessary after lifting

to a certain height, please unselect Use Limit.

Step 6  Set the pause time of point A on the Add Wait Command pane of the Playback

page, and click Add Wait Motion. If the pause time is set to 3 seconds.

The saved point information of which Type is Wait is displayed on the left pane of
the Playback page.

Step 7 Suck up the small object over the suction cup.

ANOTICE

Supposing that we use DOUT17, DOUT18 on the base I/0 interface to control the state
of air pump. DOUT17 control the intake and outtake of air pump. DOUT18 control the
startup and shutdown. The description in this topic is for reference only, the outputs
depend on the 1/0O interface used. Please replace the outputs based on site requirements.

1.

Select Output on the Add IY0O Command pane of the Playback page.
The saved point information of which Type is Output is displayed on the left
pane of the Playback page.

Select the saved point of which Type is Output on the left pane of the Playback
page, and double-click Content.

The 1/0O Command Setting page is displayed.

Select OUT17 from the 1/O drop-down list on the 1/O Command Setting page,
and select 24V, then click Add.

Add OUT18, and select 24V, then click OK.

The relevant I/O information of which Type is Output is displayed on the left
pane of the Playback page. Right-click on the line and select RunSelected on
the context menu, to make the air pump in service, and the object will be sucked
up by Dobot M1.

Step 8  Select Cartesian from Cartesian drop-down list on the Operation Panel page, and
click Z+ to lift Dobot M1. And then click X+ or other buttons to move Dobot M1 to
another point called point B.

Step 9  Save Point B. For details, please see Step 4to Step 6.

Step 10 Free small object over the suction cup.

ANOTICE

Supposing that we use DOUT17, DOUT18 on the base 1/O interface to control the state
of air pump. DOUT17 control the intake and outtake of air pump. DOUT18 control the
startup and shutdown. The description in this topic is for reference only, the outputs

depend on the I/O interface used. Please replace the outputs based on site requirements.
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1. Select Output on the Add 1/O Command pane of the Playback page.

The saved point information of which Type is Output is displayed on the left
pane of the Playback page.

2. Select the saved point of which Type is Output on the left pane of the Playback
page, and double-click Content.

The 1/0 Command Setting page is displayed.

3.  Select OUTL17 from the I/O drop-down list on the /O Command Setting page,
and select 24V, then click Add.

4. Add OUT18, and select OV, then click OK.
The relevant I/O information of which Type is Output is displayed on the left

pane of the Playback page. Right-click on the line and select RunSelected on
the context menu, and the object will be freed by Dobot M1.

LONOTE

This topics only describes one trajectory as an example. You can implement multiple
trajectories. For details, see Step 1 to Step 10.

Step 11 Click Save on the Playback page.

The Save Playback File page is displayed.

Step 12 Input the use-defined name and the saving path, and click Save. The default path of

the saved points list is Installation directory/M1Studio/config/pbstore. Please
replace the path based on site requirements.

Step 13 Click Start on the Playback page, Dobot M1 moves according to the saved points

list to suck up or free the object.

You can perform subsequent operations on the Playback page.

Select Enable Hand Hold Teach on the Playback page, the Add Motion Command
button will be unavailable. You can hold down the button under the Rear Arm to save
point after jogging Dobot M1 on the Operation Panel page or moving Dobot M1 by
hand.

Set the loop number of the saved point when implementing playback. The maximum value
is 9999. You can also select Infinite Loop to make Dobot M1 in the infinite loop state
when implementing playback according to the saved points list, as shown in Figure 6.8.

Figure 6.8 The loop number of the saved points list

Before saving a point, you can select the location of the added point on the right pane f
the Playback page, as shown in Figure 6.9
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UTDI=0V

Figure 6.9 Overwrite the current saved point

Table 6.4 lists the location description of a saved point.

Table 6.4 Description of the location of a saved point

Insert Location Description

Add At Last Add a new point after the last saved point.
Insert Before Selected Row Insert a point before the current saved point
OverWrite Selected Row Overwrite the current saved point

*  Select a saved point and double-click the parameters on the line to modify the relevant
information. The saved point information is shown as Figure 6.10.

Junp To(-108.6345, 169.3284, 104.5000, 207.7315), Height/Limit{20.0000, 200.0000), Ve

OUTPUT QUTOI=0V

Figure 6.10 The saved point information
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Table 6.5 Parameter Description of the saved point

Parameter Description
Type The command type of Dobot M1
Value:
. JUMP
. MOV
. MOVL
. ARC

e CIRCLE: The method to save points in CIRCLE mode is the
same as that of ARC mode. For details, please see 6.1.3 Saving
Point in ARC Mode

. TRIGGER
e OUTPUT
. WAIT
Name The name of the current saved point, which is user-defined
Content The contents displayed depends on Type. You can double-click contents

displayed in Content to modify them.

o MOVL/MOVJ/JUMP/ARC/CIRCLE: Indicates the coordinate values,
the velocity ratio and the jerk ratio of the movement when
implementing playback.

If Type of the current saved point is MOVL, ARC, or CIRCLE,
Armorientaion must be the same as that of the previous saved point.

In MOVL mode, if you modify the arm orientation of the current saved

point, an alarm will be generated.
. Trigger: Input of /O interface
. Output: Output of 1/0 interface

. Wait: The pause time of the previous saved point

»  Select a saved point and right-click on the line to copy, delete or other operations, as
shown in Figure 6.11.
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JUMP

2 QUTPUT

1/0 Command

Apply DynRatio

Figure 6.11 Right click options of the saved points list

*  When modify the coordinates displayed in Content of which Type is motion mode, you
can input the coordinate values manually or operate the operation panel to modify them.

1. Select the saved point on the left pane of the Playback page, double-click
contents displayed in Content.

The Motion Command Setting page is displayed, as shown in Figure 6.12.

©  Motion Command Setting

Get Current Position

JUMP Parameters
Height 00 | Limit 2C 00 @ Apply Limit

n Parameters
Vel 50 1% Jerk 50

Arm Orientation
@ Left ORight

Joint

€
/

Confirm

Figure 6.12 Modify the current saved point
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2. Click the coordinate buttons on the operation panel pane of the Motion
Command Setting page to jog Dobot M1. The coordinate is displayed on the
Operation Panel pane of M1Studio page.

3. Click Get Current Pose to obtain the coordinate of Dobot M1.
4.  Click Confirm to save the modified point.

* If modifying the speed of all saved points at the same time is necessary, you can drag
DynRatio to modify, as shown in Figure 6.13

Cantent

Tol128.9517, 208,477, 2215112, 17.7048), Vel{JerkiS0%, 50%), ArmOrientaticn

Tol219.9222, 222.0099, 2215112, 20.1946), Vel/JerkiSO%, 50%), ArmOries

Tol317.9818, 2248733, 219.5612, 21.4148), Vel/JerkiS0%, 50%), ArmOrientation(Right)

Figure 6.13 Modify the peed of all saved points at the same time

e |If you don not click Apply DynRatio, the modified speed goes into effect
temporarily. Vel and Jerk displayed on the Playback page will not be changed, and
the modified speed will not be saved if you click save.

* Ifyou click Apply DynRatio, Vel and Jerk displayed on the Playback page will be
changed, and the modified speed will be saved to Playback files if you click save.

6.3 Scripting

Prerequisites

*  Dobot M1 has been powered on.

*  Dobot M1 has been connected to a PC successfully.

*  Dobot M1 has been connected to an emergency stop switch.
Application Scenario

You can control Dobot M1 over scripting. Dobot M1 supports various API, such as
velocity/acceleration setting, motion mode setting, and 1/0 configuration, which uses Python
language for secondary development. For details about the Dotob M1 API interface and function
description, please see Dobot API Interface Document.

The download path is www.dobot.cc/downloadcenter/dobot-m1.html#most-download.
Procedure
Step 1  Select Script on the M1Studio page.
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The Script page is displayed
Step 2 Write the script.

You can double-click the interface used, the corresponding interface will be

displayed on the script file page, as shown in Figure 6.14. You can also click

icon of the corresponding interface on the left pane of the Script page to view the
way how to set the parameters. The scripting example can refer to Installation
directory/M1Studio/config/ststore/Example.script.

ANOTICE

If you use the motion command when scripting, please add the orientation command
before every motion command, which indicates the arm orientation of Dobot M1.

pallet (row:11,cok:8}

[6:17 EHATT,
[16:18:19] (65)ERR_
[16:18:21] (65)ERR,

Figure 6.14 Write a script

Step3  Click Save on the Script page.
The Save Scrip File page is displayed.

Step 4 Input the use-defined name and the saving path, and click Save. The default path of
the script is Installation directory/M1Studio/config/ststore. Please replace the path

based on site requirements.
Step 5  Click Start, and Dobot M1 will move according to the script file.

The running log will be displayed on the lower pane of the Script page for checking.
6.4 Operating Blockly

Prerequisites
*  Dobot M1 has been powered on.

*  Dobot M1 has been connected to a PC successfully.
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*  Dobot M1 has been connected to an emergency stop switch.

Application Scenario
Blockly is a programming platform based on Google Blockly. You can program through the
puzzle format, which is straightforward and easy to understand.
Procedure
Step 1  Select Tools > Blockly on the M1Studio page.
The Blockly page is displayed.
Step 2 Drag the blockly module on the left pane of the Blockly page to program, as shown

in Figure 6.15.

ready, can to edit!

Loops
Math
Text :
Lists Set Coordinate Speed VelocityRatio JerkRatio
Colour
Jump Params JumpHeight B2l ZLimit
Variables NP— - m
Functions :
do | Set Arm Orientation [Ei%8
DobotAP| T
Basic | dTIHuD & v z ﬂ
Config Set Arm Orientation (I7IED T
ion T SetPTPC. nf 17 1,20,50,1
ot umpTo X M z vl R A A
= B = hile True:
| Set Arm Orientation (G113 dTwe‘Setthrien;atioﬂx(wi. 0, 1) )
dType. SetPTPCmdEx(api, 0, 223, 276, 60, O, 1
1 [caC e 258 Al 177 Al 120 Type. SethrnOri entationkx{api, 1, 1)
o x oS v ol = ol B ot LD
dType. SethrmOri entationEx(api, 1, 1)

2 current_pose = dType. GetPose(api)
dType. SetPTPCudEx(api, 2, 258, 177, 120, current_pose[3], 1)

Figure 6.15 Blockly graphic programming

ANOTICE

Only MOVL and JUMP modes are supported when programming. If you use the motion
command when programming, please add the orientation command before every motion
command, which indicates the arm orientation of Dobot M1.

Table 6.6 Description of blockly module

No. Description

1 The selection area of blockly module, including
logistic, loop, math, and Dobot API. You can program

by dragging them to the window.

2 The window of blockly programming
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No. Description
3 The running log of Dobot M1
4 The corresponding codes of the blockly module on the

programming window

Step3  Click Save on the Blockly page.

The Save Blockly File page is displayed.

Step 4  Input the use-defined name and the saving path, and click Save. The default path of

the programing file is Installation directory/M1Studio/config/bystore. Please

replace the path based on site requirements.

Step 5 Click Start on the Blockly page, and Dobot M1 will move according to the program.

6.5 Operating Laser Engraving

Prerequisites

Dobot M1 has been powered on.

Dobot M1 has been connected to a PC successfully.

The laser kit has been installed. For details, please see 3.3.1 Installing Laser Engraving
Kit.

The picture to be engraved and materials to be processed have been prepared.

The lasing protective eyeglass has been prepared.

Procedure

Step1 Select Tools > Laser Engraving on the M 1Studio page.

The Laser Engraving page is displayed, as shown in Figure 6.16.

Figure 6.16 Laser Engraving GUI
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Step2  Click Open on the Laser Engraving page, and select the picture to be engraved, as
shown in Figure 6.17.

The picture (such as BMP, JPEG, JPG, PNG, and so on) is supported.

Seript  Web Management  Laser Engraving

4 + @rRight Hand

utoZ SyncPose (@ LeftHand

Figure 6.17 Import picture

ANOTICE

e  The imported picture should be placed in the annular region, as shown in Figure
6.17. If not, it is unable to engrave normally and the border of the imported picture
will be highlighted in red.

*  The annular region depends on arm orientation. Please adjust the imported picture
according to the real annular region. Figure 6.17 shows the annular region when arm
orientation is left.

Step 3 Click Setting on the Laser Engraving page.
The Laser Setting page is displayed.

Please set the laser engraving parameters based on site requirements.

Table 6.7 Laser engraving parameters

Parameter Description
CP Vel/ CP Acc Set the rate of CP velocity and acceleration
PTP Vel/ PTP Jerk Set the rate of PTP velocity and jerk
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Parameter Description

Grayscale Range Set the grayscale range

Value range: 0-255

Laser Power Range Set the laser power range

Value range: 2-100

Laser Height Set the laser height

Border Width Set the border width of the picture

Value range: 0-50

XBias Set XBias

DPI Set DPI

Step 4  Select Laser On on the Laser Engraving page and adjust focus.

Please wear the lasing protective eyeglass before adjusting focus.

Click the _ icon of Motor on the Operation Panel pane of the M1Studio

page and move Dobot M1 by hand to a proper height, to make the laser dot on the
material burn the brightest. When the laser power is enough, you can view burn
marks on the material.

ANOTICE

*  Please wear the lasing protective eyeglass before adjusting focal length.

* Ifthe focal length still cannot focus, you can rotate clockwise the focal length of the
laser head to adjust, as shown in Figure 6.18.

Figure 6.18 Adjust focus

ADANGER

e The laser can heat objects when it is in a focused state, so objects like paper or wood
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can be burned.
* Do not focus the laser on people or animals.

* Do not let children play with it alone. The process needs to be monitored when it is
running. After the process is completed, please turn off the laser promptly.

Step5  Click the - icon of Motor on the Operation Panel to make Dobot M1

in the open-loop state.

Step 6  Click AtutoZ on the Laser Engraving page to obtain the current Z-axis value.

After performing this step, you will not need to adjust the focus manually when you
engrave next time. You can click SyncPos directly after importing picture.

Step 7 Click SyncPos, Dobot M1 will move into the top position of the starting point

automatically.

Step 8 Click Start to start engraving.

6.6 Operating 3D Printing

Prerequisites

Dobot M1 has been powered on.
You have connected Dobot M1 to a PC over network cable or router.

The IP address of Dobot M1 and the PC must be in the same network segment. For details,
please see 5.5.3 Setting IP Address.

You have connected Dobot M1 to a PC over a serial cable.

Dobot M1 has been connected to an emergency stop switch.

The 3D printing kit has been installed. For details, please see 3.3.2 Installing 3D
Printing Kit.

Slice software Cura has been installed. The download path s
https://ultimaker.com/en/products/cura-software/list.

Please download the recommended version V14.07. The way how to install and use is not
descripted in this topic.

The 3D printing model and the firmware have been prepared.

The printing platform has been prepared and please place it in the workspace.

ANOTICE

If SN number of Dobot M1 is DT2018xxx, please switch 3D printing mode directly to
start 3D printing without update. You can view the SN number on the Help > About
M1Studio page.

xxx indicates the random number, please replace it based on site requirements.

Procedure

Step1  Select the corresponding IP address from the IP drop-down list on the upper left pane

of the M1Studio page and click Connect.
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If Connect turns to Disconnect, the connection is successful.

Step 2 Click the _ icon of Motor on the Operation Panel, and move Dobot M1

by hand to make Dobot M1 move to the position where the X-axis value is 330mm.
Step3  Switch the 3D printing firmware.
1. Select Tools > Web Management on the M1Studio page.
The Web management page is displayed.
2. Select Update Firmware in the navigation tree on the left.

The Update Firmware page is displayed, as shown in Figure 6.19.

Update Firmware

Update Type

Update Management

C  Update Fi

Test Management

& integration Test

Figure 6.19 Update Firmware GUI

3. Select 3D Printing Firmware on the Update Firmware page, and click One-
click Update to update 3D printing firmware directly.

4. Select Home in the navigation three on the left.
The Home page is displayed.

5. Select 3D printing Mode from the drop-down list on the Mode Switch
Controlling pane of the Home page and click Switch, as shown in Figure 6.20.

Mode Switch Controlling

3D Printing M..»

Switch

Figure 6.20 Switch 3D printing
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During switching, the green LED indicator will keep on. After completion, the
green LED indictor will be blinking and Current Mode is changed to 3D
Printing Mode, as shown in Figure 6.21.

Mode Switch Controlling

3D Printing M..>»

Swatch

Figure 6.21 Complete 3D printing switching

Step 4  Set slice parameters.
1. Select Machine > settings on the Cura page.
The Machine settings page is displayed.

2. Set the corresponding parameters on the Machine settings and click OK, as
shown in Figure 6.22. Table 6.8 lists the values of the parameters that need to
be set. The other parameters are set by default.

Machine settings 4
Ultimaker2
Machine settings Printer head size
E-Steps per 1mm ﬁlament| 0 Head size towards X min (rmm) CI
Maximum width (mm) 80 Head size towards ¥ min (mm) | 0
Maximurm depth (mm) 80 Head size towards X max (rmm) | 0
Maxirmum height (mm) 150 Head size towards ¥ max (mm}| 0
Extruder count il ~ Printer gantry height (mm) D
Heated bed [1 I N
Machine center 0,0 —Communication setfings
Build area shape Circular ~ Serial port com7 ~
GCode Flavor RepRap (Marlin/Sprinter) - Baudrate 115200 ~

Add new machine Remove machine Change machine name

Figure 6.22 Parameters setting

Table 6.8 3D printing parameters description

Parameter Description

Maximum width The maximum width

please set to 80mm

Maximum depth The maximum with

please set to 80mm

Maximum height The maximum height
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Parameter

Description

Please set to 150mm

Machine center 0,0

Machine center, please select it

GCode Flavor

The style of GCode
Please select RepRap Marlin/Sprinter

Build area shape

Build the area shape

Please select Circular

Serial port Serial port
Please select the corresponding serial port
Baudrate Baud rate
Please set to 115200
LONOTE

The maximum width of 3D printing that Dobot M1 supports is 200mm, the maximum
depth is 200mm, and the maximum height is 220mm. Please make 3D-print in the Dobot
M1 workspace.

3. Setslice parameters, and select File > Open Profile to import these parameters,
as shown in Figure 6.23.

The 3D printing effect depends on the slice parameters. This topic provides a

B Cura-14.07
File | Tools Machine Expert Help
Load model file... CTRL+L
Save model... CTRL+S
Reload platform F5
Clear platform g]}gm
Print... CTRL+P
Save GCode..

Show slice engine log...

Save Profile...
Lead Profile to default

Reset Profile to default

Preferences... CTRL+,
Machine settings...

Recent Model Files >
Recent Profile Files >
Quit

Figure 6.23 Import slice parameters

configuration sample, you can import it directly for printing.
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The path of the configuration  sample is Installation
directory\M1Studio(Windows)Vxxx\DobotStudio\attachment, as shown in
Figure 6.24.

xxx indicates the version of M1Studio. Please replace it based on site
requirements.

060 T *E- \ EAM1Studio(Windows)V1.0.4\ DobotStudic\attachment]

Name Date modified Type Size
3dModest] 18/01/20181028  File folder
CH341SER_WIN 18/01/201810:28  File folder
grbrMode 18/01/2018 1028 File folder
Slic3r 18/01/2018 1028 File folder
{] Dobot 2.0 Vase.ni 06/11/201710:47  Configuration set... 3KB
1| Dobot 2.0.ini 06/11/201710:47  Configuration sett... 3KB
| Dobot-2.0 Vase-Cura.ini 06/11/201710:47  Configuration sett... 11KkB
] Dobot-2.0-Cura.ini 06/11/2017 1047 Configuration sett... 11KB
22 DobotStudio_dll_X6d.exe 06/11/2017 1047 Application 1,896 KB
B DobotStudio_dil X36.exe 06/11/2017 1047 Application 1,719 KB
] Repetierl 0.6.reg 06/11/2017 1047 Registration Entries 12KB
[&]slic3r.bat 06/11/201710:47  Windows Batch File 1KB
Elvea010_164.exe 06/11/201710:47  Application 5,385 KB
Flve201006.exe 06/11/201710:47  Application 4,955 KB
#2013 64.exe 0611720171047 Application 7,027KB
#2013 x86.exe 06/11/2017 1047 Application 6,353 KB
JBvc2015:64.0ce 06/11/2017 1047 Application 14,944 KB
8l vc2015.86.0xe 06/11/2017 1047 Application 14,119 kB

Figure 6.24 Configuration sample

Dobot-2.0-Vase.ini is used for printing a thin-walled vase, while Dobot-2.0-ini
is used for the filling, the filling rate is 20%.

)
Click , the Open 3D model page is displayed, and select the 3D
printing model prepared.

The format of 3D model is STL. You can design 3D model and transform it into
STL format.

After importing the model, click the model itself, you can place it in the middle,
zoom or rotate, and so on, as shown in Figure 6.25.

.

W, D, H: 51.2, 51.2, 90.0 mm

Scale X

Scale Y 106 |
Scale Z 06 | \ :
Size X (mm) BN '
Size Y (mm) HI N B

Size Z (mm) ENCEEE .

Uniform scale [+

Figure 6.25 Zoom and rotate
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—
L

5. Click =1 to connect Dobot M1.

The printing window is displayed and the current printing temperature is shown
on the top corner of the window, as shown in Figure 6.26.

[+ Operational. Temperature: 28 CSREey x|

Figure 6.26 Printing window

6. Set Temperature to 200 and press down Enter to heat the extruder.

The temperature of the extruder should be above 170°C. Dobot M1 will not start
3D printing until the filament is in the melting state. So you need to heat the
extruder first.

ADANGER

The heating rod will produce high temperature up to 250°C, please be careful. Do not let
children play with it alone. The process needs to be monitored when it is running. After
the process is completed, please turn off the equipment promptly.

Step S  Test the extruder.

Before printing, you need to test the extruder to check whether the melted filament
flows from the nozzle of the extruder.

Click the feedstock extruder or click the given stepper, such as 10, 1, 0.1 (10 is
recommended) on the Operational page and feed up to 10mm-30mm, as shown in
Figure 6.27.
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1| Operational Temperature: 199
Connect [ Print |

Temperature

=200 2
Bed temp.
3 =

9

Figure 6.27 Click feedstock extruder

If the melted filament flows from the nozzle of the extruder, the extruder is working

properly.
Step 6  Adjust the printing space and get printing coordinates.
1. Click-ZorClick 10, 1, 0.1 to move Dobot M1 to the position where the distance
from nozzle to the printing platform is about 0.3mm, as shown in Figure 6.28.

® 7 Uperational, lemp e aw

0.1
10 D
Temperature
nso | Il T | &
100
| R I Bed temp
3 EEEEl

Figure 6.28 Move Z-axis

LONOTE
During printing, if the distance from Dobot M1 to the printing platform is too large or
too small to paste the first layer, it can lead to the nozzle blockage. For increasing the

stickiness of the first layer, placing a masking paper on the platform is recommended.
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2. Input command M415 on the lower right of the Operational page to save the
printing coordinates, as shown in Figure 6.29.

Figure 6.29 Input command M415

Step 7  Click Print, Dobot M1 moves to the printing origin (System setting) and starts to
print.

ANOTICE

If the yellow LED indicator is always on when printing, the connection between Dobot
M1 and 3D printing Kit is poor. Please check the connection and restart Dobot M1.

6.7 Operating I/O Assistant

Prerequisites
e Dobot M1 has been powered on.
*  Dobot M1 has been connected to the PC successfully.
*  Dobot M1 has been connected to the emergency stop switch.
*  The air pump has been installed (If you use air pump to debug /O interface).
Application Scenario
The end effectors such as gripper, suction cup need to work with the air pump. The air pump
can be controlled by the 1/O interface. You can verify the I/O interface and the air pump over 1/O
Assistant.
Procedure
If the air pump is connected to the base 1/O interface, the outputs used are DOUT17, DOUT18
respectively. For details, please see 3.4 (Optional) Installing Air Pump. The DOUT18 output
controls the startup and shutoff of the air pump.
Step1  Select Tools > 1/0 Assistant on the M 1Studio page.
The 1/0 Assistant page is displayed.
Step2  Click 24V of OUT18 on the Output pane of the I/O Assistant page, as shown in
Figure 6.30.
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Figure 6.30 1/O assistant

The air pump is humming, which indicates that the air pump is enabled. The working
state depends on the air pump. Please judge based on site requirements.

Step3  Click 0V of OUT18 on the Output pane of the I/O Assistant page

The air pump is not humming, which indicates that the air pump is disabled.

6.8 Operating Web Management

The web management of Dobot M1 integrates offline file management, firmware update, and
application update, which is used to upload the offline files, make Dobot M1 in offline mode, and
update the applications.

6.8.1 Managing Offline File
You can upload the scripts, the blockly programs, or the saved points lists that have been saved
on a local PC to Dobot M1 using the web management, to perform offline operation.

After making Dobot M1 in offline mode using the web management, Dobot M1 will be
disconnected from M1Studio. You need to switch the operation mode of Dobot M1 using the web
management.

Prerequisites
*  You have started M1Studio.
*  You have connected Dobot M1 to a PC over a network cable.
*  You have powered on Dobot M1.

*  The IP address of Dobot M1 and the PC must be in the same network segment. For details,
please see 5.5.3 Setting IP Address.

*  You have saved the scripts, the blockly programs, or the saved points lists.
*  Dobot M1 has been connected to an emergency stop switch.
Application Scenario
If Dobot M1 need to be running in offline mode, please use the web management.

Procedure
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Step1  Select the corresponding IP address from the IP drop-down list on the upper left pane
of the M1Studio page.
Step2  Select Tools > Web Management on the M1Studio page.
The Web Management page is displayed.
Step3  Select Offline Script Management in the navigation tree on the left.
The Offline Script Management page is displayed.
Step 4 Click Add File.
The Add File page is displayed.
Step 5 Click Select the Files to Upload.
The uploaded file dialog box is displayed, as shown in Figure 6.31.
@ Open X
Organise v New folder ; ) ‘ h Bz ™ @
g:::t?:d::x:j; Snsamp\esmp( 1:?:-”;;‘7::53 SJCPRTPTFHE h 28
Figure 6.31 Upload files
Step 6  Select files which need to be offline executed in the folder that contains offline files,
and click Open.
Only support the files, of which the suffixes are .playback, .blockly, and .script.
Step 7  Click Upload. You can view the status, as shown in Figure 6.32.
Upload Offline Script
&aSelect the File to Upload
Example-blockly Speed3.18K/S Uploaded
Size3.54K Details3.54K / 3.54K
Figure 6.32 Status of Uploading
Step 8 Select the uploaded files that need to be offline executed on the Offline Script
Management page, and click Offline to make the files in offline mode, as shown in
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Figure 6.33,

Offline Script Management

B Delete All @ Delete List

Whether run as offline mode

Figure 6.33 Status of the uploaded files

Step 9  Select Home in the navigation three on the left.
The Home page is displayed.

Step 10 Select Offline Mode from the drop-down list on the Mode Switch Controlling pane
of the Home page, and click Start to make Dobot M1 in the Offline Mode status, as
shown in Figure 6.34. Dobot M1 is disconnected from M1Studio, and Dobot M1 can
be running according to the files that are in offline mode.

Mode Switch Controlling

Offline Mode - OD0T VIO

Current Mode

Figure 6.34 Status of Dobot M1

6.8.2  Upgrading Application

When the firmware or other applications need to be upgraded, you can use the web manager to
upgrade the firmware or the application. This topic uses the firmware upgrade as an example to
describe the operation.

ADANGER

When updating firmware, please do not perform any other operation on Dobot M1 or
power off Dobot M1sss, to avoid Dobot M1 in abnormal condition. Otherwise, it will be
vulnerable to injury the device or the person.
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Prerequisites
*  You have connected Dobot M1 to a PC over a network cable.
*  You have powered on Dobot M1.

e The IP address of Dobot M1 and the PC must be in the same network segment. For details,
please see 5.5.3 Setting IP Address.

* You have obtained the latest firmware.
* You have connected Dobot M1 to an emergency stop switch.
Procedure

Step1  Select the corresponding IP address from the IP drop-down list on the upper left pane
of the M1Studio page.

Step 2 Select Tools > Web Management on the M1Studio page.
The Web Management page is displayed.
Step3  Select Update Firmware in the navigation tree on the left.

The Update Firmware page is displayed, as shown in Figure 6.35.
(® boBoT

#  Home

Update Firmware

File Management

Figure 6.35 Update Firmware GUI

Step 4  Select the firmware that need to be upgraded, and click One-click Update to update
directly from main controller,

You can view the process of the firmware upgrade. If the progress bar is 100%, the
update is completed, as shown in Figure 6.36.

Update Firmware

Update Type Properties IsLastVersion Status.

Dobot Firmware: - One-click Update
Size-

3D Printing Firmware:- faitin One-click Update
Size-

Figure 6.36 Process of the firmware upgrade
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6.9 Example
6.9.1 Example of the Trajectory

This topic describes how to use the motion modes according to the real trajectory when Dobot
M1 is running.

Figure 6.37 shows the real trajectory when Dobot M1 is running. Figure 6.38 shows the
coordinates of the trajectory.

ANOTICE

This topic only describes the motion modes that need to be used and precautions for
implementing playback, without details about the trajectory. For details on how to
implement playback, please see 6.2 Operating Teaching and Playback.

Figure 6.37 Trajectory of Dobot M1

Issue V1.0.4 (2018-08-30) User Guide Copyright © Yuejiang Technology Co., Ltd
83




0 DOBOT

Dobot M1 User Guide 6 Operation

200.0

160.0

1200

-200.0

Figure 6.38 Cartesian coordinate of the trajectory

If point A is the starting point, and Point B is the end point. From Point A to Point J, the

coordinates are listed as Table 6.9.

Table 6.9 Cartesian coordinates

Point Coordinate (x,y,z,r)

A (270,-244,110,0)

B (400,0,110,0) (Singular point)

C (366,111,110,0)

D (194,111,110,0)

E (194,277,110,0)

F (85,250,110,0)

G (-44.4458,239.5284,110,33.08) (The middle point of
the arc)

H (-120.6913,164.5902,110,65.6601)

| (372.225,-63.2786,110, -148.8402)

K (351.7533,-113.7360,110, -160.2802) (The middle
point of the circle)

J (323.1731,-115.7006,110, -170.5002)

Figure 6.39 shows the example of the saved points list.
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6.9.2

0
1
2
3
4
5
6
7
8

MOVJ To(270.0000, -244.0000, 110.0000, 0.0000), Vel/Jerk(100%, 100%), ArmOrientation(Right)

MOV] To(400.0000, 0.0000, 110.0000, 0.0000), Vel/Jerk(100%, 100%), ArmOrientation(Right)

Jump To(366.0000, 111.0000, 110.0000, 0.0000), Height/Limit(20.0000, 200.0000), Vel/Jerk(100%, 100%), ArmQrientation(Right)
MOVL Te(124.0000, 111.0000, 110.0000, 0.0000), Vel/Jerk(100%, 100%), ArmOrientation(Right)

MOVL To(124.0000, 277.0000, 110.0000, 0.0000), Vel/Jerk(100%, 100%), ArmOrientation(Right)

Jump To(85.0000, 250.0000, 110.0000, 0.0000), Height/Limit(20.0000, 200.0000), Vel/)erk(100%, 100%), ArmOrientation(Right)

ARC Via(-44.4458, 239.5284, 110.0000, 33.0800), Toi-120.6913, 164.5902, 110.0000, 65.6601), Vel/Jerk(100%, 100%), ArmOrientation(Right)
Jump To(372.2250, -63.2786, 110.0000, -148.8402), Height/Limit(20.0000, 200.0000), Vel/Jerk(100%, 100%), ArmOrientation(Left)

CRICLE Via(351.7533, -113.7360, 110.0000, -160.2802), To(323.1731, -115.7006, 110.0000, -170.5002), Count(l), Vel/Jerk(100%, 100%), ArmOrientation(Left)

Figure 6.39 Example of the saved points

From point A to point B (0->1): The trajectory is non-linear, and point B is a singular
point. So MOVL or ARC mode cannot be used, but MOVJ mode is applicable. For details
about singular point, please see 6.1.2 Alarms Description.

From point B to point C (1->2): The trajectory looks like a door. So JUMP mode is
required. You need to set Height and Limit when saving point. The trajectory in JUMP
mode depends on Height and Limit. For details, please see 2.3.4.2 Point to Point Mode
(PTP).

From point C to point D (2->3): The trajectory is a straight line. So MOVL mode is
required. The arm orientations of point D and point C must be the same. Otherwise, an
alarm will be generated.

From point D to point E (3->4): The trajectory is a straight line. So MOVL mode is
required. The arm orientations of point E and point D must be the same.

From point E to point F (4->5): The trajectory looks like a door. So JUMP mode is
required. You need to set Height and Limit.

From point F to point H (5->6): The trajectory is an arc. So ARC mode is required. Besides
point F and point G, you need to save point G. For details, please see 6.1.3 Saving Point
in ARC Mode. The arm orientation of point F must be the same as that of point G and
point H.

From point H to point | (6->7): The trajectory looks like a door. So JUMP mode is
required. You need to set Height and Limit.

From point | to point J (7->8): The trajectory is a circle. So CIRCLE mode is required.
Besides point I and point J, you need to save point K. The method to save pointin CIRCLE
mode is the same as that of ARC mode. The arm orientation of point | must be the same
as that of point J and point K.

Example of the External Drive

The current of the digital output supports 2mA without additional power, whereas the

maximum current of the digital output supports 3A with additional power. Because the default
drive capacity of Dobot M1 is insufficient. When the control device that is connected to the
I/0 interface need to provide a sufficient drive capacity, you must have an external drive to
increase the drive capacity.

Figure 6.40 shows the connection between 1/O interface and control device without

additional power.
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VCC_24V is the output voltage of the I/O interface of Dobot M1. OUTx are the outputs
of the 1/O interface (assuming that OUTO and OUT1). Please select the proper outputs based

on site requirements. For details, please see 4.3 Interface Description.

VCC_24V
1 24y /0>
Magnetic
10k Valve
£ OUTx ><
MCU — /o)

GND

Internal Circuit

Figure 6.40 Connection between 1/O interface and control device by default

Figure 6.41 shows the connection between I/O interface and control device with additional
power. The red box in Figure 6.41 shows the external drive circuit. You can make an external drive
circuit to meet the drive capacity requirements according to Figure 6.41.

* VCC_24V is the output voltage of the I/O interface of Dobot M1. OUTx are the outputs
of the I/O interface (assuming that OUTO and OUT1). GND is the ground of the 1/O
interface. Please select the proper outputs based on site requirements. For details, please
see 4.3 Interface Description.

* 24V is the external voltage. PGND is the ground corresponding to the external voltage.

6.9.3

Internal Circuit

VCC_24V i 24v
/o) Magnetic ~ (External)
Q Valve ‘
24V I
i o
10k
10k
I -
T
OUTx PGND
MCU — & 1/0) 10k (External)
~ GND
ND
¢ /o)

Figure 6.41 Connection between /O interface and control device with external drive

Example of Switching the Arm Orientation at the Same Point

In MOVJ or JUMP mode, if the two points are the same, only different in arm orientations, J1
or J4 may be limited when Dobot M1 is moving, resulting in an alarm generated. You need to modify
and resave the point for which the alarm is generated, and then clear the alarm manually.

The R-coordinate is the sum of the coordinates of J1, J2 and J4. The terminal posture relative
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to the origin stays constant when moving Dobot M1. Table 6.10 lists how to calculate each Joint
coordinate after switching the arm orientation at the same point.

Table 6.10 Joint coordinate calculation

Before After

R=J1+J2+J4 R’=R=J1’+J2’+]4’
J1 JI’=J1+]2

J2 J2°=-J2

J3 J3°=J3

J4 J4’=R-J1°-12°

As shown in Table 6.10, If the J1-coordinate is 10 and the J2-coordinate is 90 before
switching the arm orientation, the J1-coordinate will change to 100 <after switching, resulting in an
alarm about limit generated. In real application scenario, if the two successive saved points are the
same, only different in arm orientations, please notice the coordinates of J1 and J4. You can calculate
J1-coordinate and J4-coordinate according to Table 6.10, in order to avoid generating an alarm about
limitation.
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7.1 Routine Maintenance
711 Routine Inspection

Due to the temperature, humidity, dust and vibration, the components will be aged, leading to
reducing product service life. Performing maintenance inspections and procedures properly is
essential for preventing trouble and ensuring safety. Especially in high temperature environment,
frequently start-stop scenario, and other special scenarios, you need to shorten the inspection period.

To ensure product function and safety, please check the following items daily.

Item Operating state Inspection point Solution
External cable OFF . Check whether | ¢ If the cables are
cables are damaged damaged or
or cracked cracked, please
e check whether repair or replace
cables are loose, them timely
dirty or polled out e If the cables are
loose or polled out,
please plug them
properly
e If the cables are
dirty, please clean
them timely
Bolt, screw OFF . Check whether the | If the bolts are loose,
bolts on the end | please tighten them
effector are loose
. Check whether the
bolts on the base are
loose
Cover OFF Please check the covers | If that happens, please
of robotic arm are flawed | replace them timely
Startup ON Check whether robotic | If the connections
arm is shaken are abnormal,
please  reconnect
them
. If the screws are
loose, please tighten
them
Emergency stop switch, | ON Check whether the LED | If that happens, please
LED indicators and indicators are displayed | replace the corresponding
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Item Operating state Inspection point Solution
buttons normally and emergency | components timely
stop switch is working
regularly
7.1.2  Periodic Inspection

In order to keep the good operation of robotic arm, please check the place where it is hard to
check regularly. The inspection period depends on the operating environment and frequency, please
decide the inspection period based on site requirements. Please remove surface dust effectively to
prevent dust (especially metal dusts) from entering the product, ensuring that robotic arm is always

clean.

Item

Operating state

Inspection point

Inspection period

Solution

wheel of R-axis

synchronizing
wheel is loose

Internal  fan  of | ON . Check 3 months . If the fan is
robotic arm whether  the out of service,
fan is running please replace
properly it
. Check . If the fan is
whether the dirty, please
fan is dusty use
compressed
air to clean
surface dust
Mechanical OFF Check whether | 6 months If that happens,
limitation of J1, J2, joints are cracked please replace it
J3 timely
Synchronizing OFF Check whether the | 6 months If that happens,

please re-tension it
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Item

Operating state

Inspection point

Inspection period

Solution

Bolt, screw

OFF

. Check

whether  the
screws  and
bolts around
each joint of
robotic arm

are loose

. Check

whether  the
screws  and
bolts of motor
and  reducer

are loose

12 months

If that happens,

please tighten them

Enabling Robotic

arm

ON

Check whether each
arm can be moved
by hand in the open-
loop state

12 months

If that happens,

please contact
technical  support

engineer

7.1.3

Cleaning Maintenance

The cleaning period depends on the operating environment and frequency, please decide the
cleaning period based on site requirements.

Item

Operating state

Cleaning period

Solution

Robotic arm

OFF

1 month

Please clean the surface
with clean cloth

Wind tunnel

OFF

2 weeks

Please clean the
impurities stored in the
wind tunnel with air gun

or clean cloth

Screw rod of Z-axis

OFF

12 months

Please add lubricating oil
or grease. For details,
please see 7.2.1 Greasing

Screw Rod of Z-axis

Guide rail of Z-axis

OFF

2 weeks

Please add lubricating oil
or grease. For details,
please see 7.2.2 Greasing

Guide Rail of Z-axis

Common disinfectant, cleaning liquid can be used for cleaning robotic arm. Please do not use
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acidic cleaning fluid for routine maintenance.

7.2 Maintenance of Mechanical Parts

7.21 Greasing Screw Rod of Z-axis

If the grease on the screw rod has been used up, the screw rod may be worn down and make a
noise. You need to check the grease every other year. If the grease is applied too much or uneven,
the load of motor may be increased and the grease may be dripped from the screw rod. You can
check whether the grease is used up by wiping the surface of the screw rod with air-laid paper. If
there is no grease on the air-laid paper, the grease is used up.

Procedure

Step1 Please power off Dobot M1 and remove the Z-axis cover with 2.5# hexagon wrench.

Step 2 Restart Dobot M1.

Step3  Select the corresponding serial port from the serial drop-down list, and click
Connect.
If Connect turns to Disconnect, the connection is successful, and Dobot M1 can be
controlled by M1Studio.

Step4  Click the _ icon of Motor on the Operation Panel pane of the M1Studio
page to make Dobot M1 in the open-loop state

Step5 Move Dobot M1 to the bottom of Z-axis by hand.

Step 6  Apply moderate amount of grease on the screw rod. The type of grease is 3# Lithium
Grease.
Please apply the grease evenly with specialized oil brush. Figure 7.1 shows the screw
rod of Z-axis.

Figure 7.1 Screw rod of Z-axis
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Step 7
Step 8
Step 9

Step 10

Move Dobot M1 to the top of Z-axis by hand.
Apply a small quantity of grease evenly on the bottom of the screw rod.

Move up and down the Z-axis to the limitation repeatedly (3-5 times) to scrap the
grease stored on each end.

Power off Dobot M1 and install the Z-axis cover with 2.5# hexagon wrench.

It can be put into use after installation.

7.2.2 Greasing Guide Rail of Z-axis

If the guide rail is used without grease, the guide rail will be worn down and the service life
will be reduced. You need to grease the guide rail every two weeks for long service.

Prerequisites

Please prepare the correct-size syringe (a diameter of no more than 2cm) and needle to ensure
that the syringe can touch the guide rail of Z-axis.

Procedure
Step 1
Step 2

Move Dobot M1 to the bottom of Z-axis and power off Dobot M1,

Stretch the syringe with needle into the guide rail from the gap in the top of the shell
of Z-axis, as shown in Figure 7.2. Inject two or three drops of grease on each side of
guide rail respectively. The grease of which the kinematic viscosity is 30cst to 150cst

is recommended, such as engine oil.

After 15 minutes, restart Dobot M1 to put it into use.

Figure 7.2 Guide rail of Z-axis

7.3 Maintenance of Electrical Parts
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ANOTICE

Please notice the anti-static precautions during electrical operation, such as wearing anti-

static wrist strap to ensure that the internal parts of robotic arm are not damaged.

7.3.1 Replacing Encoder Battery

The battery is located on the main controller of the base or Forearm. The position of the battery
depends on the production batch of Dobot M1.

When the battery voltage is less than 3V, an alarm about low battery voltage is generated, it is
necessary to replace the battery. The replacement period depends on the operating frequency, please
decide the replacement period based on site requirements. Normally, the battery needs to be replaced

once a year.

AWarning

If a fuse is not installed on the battery, please contact technical support engineer.
We will provide the replacing solution of the Encoder battery with a fuse.

If a fuse is not installed on the battery, in some cases, for example, disassembling
machine without professional may cause wire breakage and battery charging,
leading to equipment damage or even battery explosion.

Table 7.1 Replacement parts list

Type Name Quality Remark
Maintenance parts Battery with welding | 1 -
cable LS 14250
Wire tie 1 Please prepare by
yourself
Tools Hexagonal wrench 1 -
(2.5mm)
Cross head screw- | 1 Please prepare by
driver yourself
Nippers 1 Please prepare by
yourself
Insulating tape 1 Please prepare by
yourself
M\norice
After replacing the battery, please do not dispose elsewhere. All discarded batteries must
be uniformly reclaimed to avoid environmental contamination.
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Procedure

Step1 Hold down the power button in the base of Dobot M1 for about 5 seconds, and then
release your fingers to power off Dobot M1. Pull out the power plug from the power
source to shut off power to the robot system.

Step 2 Detach all cables from the interface board of the base.
Step 3  Check the location of the battery and remove it.
e [fthe battery is located on the base, please perform the following steps.

1. Loosen the four screws on the interface board of the base using 2.5# hexagonal
wrench, as shown in Figure 7.3.

Figure 7.3 Interface board of the base

2. Move out the main controller from the base.

Please move out the main controller lightly to prevent disconnection between
the main controller and the robotic arm.

3. Remove the original battery.
LONOTE

After removing the battery from the main controller on the base, you need to install the
battery to be replaced on Forearm instead of the base. For details, please see Step 4 to
Step 9.

» If a fuse is installed on the battery, please cut off the wire tie that fixed the
original battery, as shown in Figure 7.4. Remove the battery from the battery
holder and disconnect the connector of the original battery to the battery adapter
cable, as shown in Figure 7.5.

After removing the original battery, please wrap the connector of the battery
adapter with insulating tape to prevent short circuit.
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Figure 7.4 Location of battery holder

Figure 7.5 Disconnect the connector of the battery to the battery adaptor cable

» Ifafuseis notinstalled on the battery, please remove the cover of battery holder
to take out the original battery and detach the battery connector of bus cable
connecting to the battery holder, as shown in Figure 7.6.
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After removing the original battery, please wrap the battery connector of the bus
cable with insulating tape to prevent short circuit.

Figure 7.6 Connection between battery and robotic arm

4. Put the main controller into the base, and fix the interface board.
* Ifthe battery is located on Forearm, please perform the following steps.

1. Remove the Forearm cover with 2.5mm hexagon wrench and cross head screw-
driver, as shown in Figure 7.7.
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Figure 7.7 Forearm of Dobot M1

2. Cut off the wire tie that fixed the original battery, as shown in Figure 7.8.

Figure 7.8 Location of battery holder on Forearm

3. Remove the original battery and disconnect the connector of the battery to the
battery adapter cable, as shown in Figure 7.9.
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Figure 7.9 Disconnect the battery to the batter adapter

Step4 Remove the Forearm cover with 2.5mm hexagon wrench and cross head screw-
driver. If it has been removed, please skip this step.

Step5 Connect one end of the battery adapter cable to the battery interface on the Driver
Board, as shown in Figure 7.10. If it has been connected, please skip this step.

Figure 7.10 Connect the battery adapt to the battery interface
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LAONOTE

There are two battery interfaces on the Driver Board, as shown in the red box of Figure
7.11. You need to connect the battery adapter to the unused battery interface.

 CSmbte N

rﬂf_.__*_ %oooo
EQ —1 OOOO
t‘! 00000000 |%=2%

Figure 7.11 Battery interfaces on the Driver Board

Step 6 Connect the connector of the standby battery to the other end of the battery adapter
cable, as shown in Figure 7.12.

Figure 7.12 Connect the battery to the batter adapter
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Step 7  Insert the wire tie to the battery holder on Forearm to fix battery, as shown in Figure
7.13.

Figure 7.13 Insert wire tie

Step 8 Put the standby battery into the battery holder as shown in Figure 7.14 and cut off
the redundant wire tie.

Figure 7.14 Put battery into battery holder

Step9  Re-fix the Forearm cover.
Step 10 Reconnect the external equipment required to Dobot M1, and restart Dobot M1.
Step 11 Reset Encoder.
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After replacing the battery, the position data on the Encoder will be lost. It is
necessary to reset Rear Arm Encoder, Forearm Encoder, Z-axis Encoder and R-axis
Encoder respectively.

Click Initialization.exe in the installation

directory/M1Studio/tools/Initialization directory.

The M1Studio tool page is displayed.

Select the corresponding serial port from the serial drop-down list, and click
Connect.

If Connect turns to Disconnect, the connection is successful, and Dobot M1
can be controlled by M1Studio.

Click Reset Encoderl, Reset Encoder2, Reset Encoder3, and Reset
Encoder4 respectively on the Debug page to reset J1 Encoder, J2 Encoder, J3
Encoder and J4 Encoder, as shown in Figure 7.15.

Calibration Debug ServoSetting HardwareInfo About Board Test

Reset Encoder 1 Reset Encoder 2

Reset Encoder 3 Reset Encoder 4

UserParam5
UserParamé
UserParam7
UserParam8

Home InitPos

Figure 7.15 Reset Encoders

Restart Dobot M1.

Check whether encoders are reset on the Debug page. Please check the default
values of the encoders (UserParam5 to UserParama). If the values range from
163790000 to 196548000, the operation is successfully.

Select the corresponding serial port from the serial drop-down list, and click
Connect.
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If Connect turns to Disconnect, the connection is successful, and Dobot M1
can be controlled by M1Studio.

7.  Click the _ icon of Motor on the Calibration page to make the

motor of Dobot M1 in the open-loop state.

8. Jog Dobot M1 by hand to make Rear Arm and Forearm in a straight line and
perpendicular to the base forward, and then jog Dobot M1 to the bottom of Z-
axis, as shown in Figure 7.16.

Figure 7.16 Location of Dobot M1 after Factory calibration

9. Click the _ icon of Motor on the Calibration page to make the

motor of Dobot M1 in the close-loop state.

10. Click InitPos on the Debug page to make Dobot M1 in the origin position of
which the coordinate is (400,0,0,0).

ANOTICE

After restoring factory setting, an alarm about limitation is generated and meanwhile the
red indicator on the base of robotic arm is on, which is a normal phenomenon. At that
point, you need to click J3+ under Joint coordinate system to jog robotic arm to the
position where the J3 value is above 10mm, and then the alarm will be cleared.

Step 12 After resetting Encoder, you need to calibrate J2. For details, please see 7.3.2
Calibration.

7.3.2  Calibration
In real applications, the high absolute precision of robotic arm is required. The origin
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(400,0,0,0) has been set by default, Dobot M1 can be directly put in use. After parts (motors,
reduction gear units, battery, etc.) have been replaced or robotic arm has hit the work piece, the
origin of Dobot M1 will be changed. You need to reset the origin. When Dobot M1 moves with
different arm orientation, the high precision of J2 is required. Therefore, after resetting the
origin, you need to calibrate J2 to improve the absolute precision.

Generally, before and after switching the arm orientation at the same point, the J2
coordinates are axisymmetric. After resetting the origin, the J2 coordinates may become non-
axisymmetric, resulting in that Dobot M1 cannot move to the same point with different arm
orientation when implementing playback. It is necessary to make the J2 coordinates
axisymmetric by compensating the joint angel of J2 to improve the absolute precision after
resetting the origin. So that Dobot M1 can move to the same point with different arm orientation
when implementing playback.

Prerequisites
e Dobot M1 has been powered on.
e Dobot M1 has been connected to the PC successfully.
*  Dobot M1 has been connected to the emergency stop switch.

*  The pen holder kit has been installed on the terminal. The size of the pen holder should
be according with the size of the terminal. For details, please see 3.3 (Optional) Installing
End Effector.

*  Please prepare an A4 sheet of paper, and draw a small dot as a calibrated point, as shown
in Figure 7.17 .

Figure 7.17 Calibration point

Procedure

Step1 Put the A4 sheet of paper into the workspace of Dobot M1.
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Step 2

Step 3

Step 4

Step 5

Step 6

Click Initialization.exe in the installation directory /M1Studio/tools/Initialization
directory.

The M1Studio tool page is displayed.

Select the corresponding serial port from the serial drop-down list, and click
Connect.

If Connect turns to Disconnect, the connection is successful, and Dobot M1 can be
controlled by M1Studio.

Click the _ icon of Motor on the Calibration page to make the motor

of Dobot M1 in the open-loop state.
Jog Dobot M1 by hand.

Move Dobot M1 with righty hand orientation to touch the calibrated point that is on
the A4 sheet of paper, as shown in Figure 7.18.

Figure 7.18 Calibration as righty hand orientation

Click P1 on the Calibration page to save the point in Step 5.

The value of P1 is J2 coordinate with righty hand orientation, as shown in Figure
7.19.
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Calibration Debug s Setting HardwareInfo About Board Test

Calibration Params
P1 P2 0.0000

Motion Params
yA BTyl 100.0000 Auto

Pause Time m S
Z of Jump2 K/l @ Auto

Joint

Power :

ClearAlarm Confirm

Figure 7.19 Save J2 coordinate with righty hand orientation

Step 7 Jog Dobot M1 by hand to the same point in Step S with lefty hand orientation, as
shown in Figure 7.20.

Figure 7.20 Calibration with righty hand orientation
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Step 8 Click P2 on the Calibration page to save the point in Step 7.
The value of P2 is J2 coordinate with lefty hand orientation, as shown in Figure 7.21.

Calibration Debug ServoSettinzg HardwareInfo About Board Test

Calibration Params
P1 89.1258 P2 -87.1878

Motion Params
Byl 100.0000 Auto

Pause Time m S
Z of Jump2 PN/l @ Auto

Joint

Power :

ClearAlarm Confirm

Figure 7.21 Calibration as lefty hand orientation

Step 9 Click the - icon of Metor on the Calibration page to make the motor of

Dobot M1 in the close-loop state.

ANOTICE

After saving P1 and P2, you cannot click Confirm until the motor of Dobot M1 is in the
close-loop state.

Step 10 Click Confirm to make Dobot M1 move according to the calibrated point. Dobot M1
will finally move to (400,0,100,0).

ADANGER

Dobot M1 starts to work after clicking Confirm. Please do not enter the workspace of
the robotic arm, otherwise it will be vulnerable to injury the device or the person.
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